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1 Introduction 
This Pre-Design Investigation Data Summary Report (DSR) summarizes the field investigations 
conducted as part of the pre-design investigation (PDI) at the former Reynolds Metals Reduction 
Plant (Former Reynolds Plant) in Longview, Washington. The PDI was conducted in February and 
April 2020 and February 2022. This DSR is an appendix to the Final Engineering Design Report, 
Version 2 (Final EDR), prepared in accordance with the cleanup action as specified in the Cleanup 
Action Plan (Ecology 2018a) pursuant to Consent Decree No. 18-2-01312-08 (Ecology 2018b).  

1.1 Site Description 
The site is located at 4029 Industrial Way near Longview, Washington, in unincorporated 
Cowlitz County. The property includes about 460 acres and is currently operated as a multimodal bulk 
materials handling facility. The site is approximately 10 feet above mean sea level and bounded by the 
Columbia River to the south; Consolidated Diking Improvement District (CDID) drainage ditches to the 
north, west, and east; Industrial Way along the northern boundary; and private property to the east.  

1.2 Purpose 
The purpose of this appendix is to document the geotechnical and groundwater fluoride screening 
sampling techniques used and the results of the PDI. This appendix supports the Final EDR by 
characterizing the geotechnical conditions of site units (SUs) in order to perform engineering 
evaluations for cleanup action design and to screen fluoride concentrations in groundwater along 
the extent of the conceptual permeable reactive barrier (PRB) to determine design alignments. 
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2 PDI Data Collection Summary 
The PDI conducted at the site included an array of geotechnical and groundwater fluoride screening 
sampling techniques to characterize the geotechnical properties present at the following SUs: SU1, 
SU2, SU6, SU7, SU8, and SU10, and to screen fluoride concentrations in groundwater along the 
extent of the conceptual PRB. This work was conducted per the Pre-Design Investigation Work Plan 
(PDI Work Plan; Anchor QEA 2019a) and associated addenda (Anchor QEA 2020a, 2020b, 2022) 
approved by the Washington State Department of Ecology (Ecology). The PDI Work Plan was 
approved on March 15, 2019; however, field work could not commence until the U.S. Army Corps of 
Engineers (USACE) provided authorization to work in the levee. The USACE authorization and CDID-
issued levee encroachment permit were received on January 7, 2020. The PDI Work Plan Addendum 
(Anchor QEA 2020a) was submitted to Ecology on February 4, 2020, and work commenced on 
February 10, 2020. A second PDI mobilization occurred in April following Ecology’s approval of the 
Pre-Design Investigation 2 (PDI2) Work Plan Addendum (Anchor QEA 2020b) on April 13, 2020.  

An additional Pre-Design Investigation 3 (PDI3) Work Plan Addendum (Anchor QEA 2022) was 
submitted to Ecology on February 15, 2022. This addendum authorized the performance of two 
additional geotechnical borings performed to support foundation design of two stormwater 
structures proposed within the vicinity of SU7, a pump station on a gravel pad to the west of 
Berth Road and a 48-inch manhole to the east of Berth Road. Additional geotechnical sampling 
techniques were conducted to characterize the geotechnical properties present in the proposed 
vicinity of the pump station and manhole. Mobilization for PDI3 occurred on February 22 
and 23, 2022, following Ecology’s approval of the PDI3 Work Plan Addendum (Anchor QEA 2022) on 
February 16, 2022. 

To reduce the potential for adverse effects on cultural resources, the Cultural Resources Coordination 
Plan (CRCP; AECOM 2019) was followed during the PDI. The CRCP provides procedures to be 
followed in the event of an unanticipated human remains or archaeological discovery, with or 
without a monitor being present, in compliance with federal and state laws protecting these 
resources. Archaeological monitoring, overseen by a professional archaeologist, occurred for 
exploration activities where soil was removed, including direct push soil core collection and sonic 
borings. The following sections summarize the PDI findings. 

2.1 Direct Push Fluoride Screening Sampling 
Eight direct push probes (PDI-PRB-DP-01 through PDI-PRB-DP-08) were advanced adjacent to the 
western side of the Closed Black Mud Pond (BMP) Facility to screen fluoride concentrations in 
groundwater (Figure A1). The direct push probes were advanced by Holocene Drilling, Inc., under 
supervision of Anchor QEA staff between February 10 and 14, 2020.  
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Discrete groundwater samples for fluoride field screening were collected using procedures outlined 
in the Pre-Design Investigation Sampling and Analysis Plan (SAP; Anchor QEA 2019b). Temporary well 
screens were installed using a direct push drilling rig at 5-foot intervals starting at ground surface 
down to 30 feet below ground surface (bgs) or refusal. For each 5-foot interval, the screen was 
advanced to the target sampling depth using the closed-tip method described in the Fluoride Field 
Screening Using Direct Push Drilling standard operating procedure (SOP) included as Attachment A1. 
Once the target sampling depth was reached, the screen was exposed to the aquifer, and if enough 
water entered the temporary well, a sample was collected for fluoride field screening and water 
quality parameters.  

A follow-up direct push field investigation (PDI2) was conducted on April 15 and April 16, 2020, per 
the Ecology-approved PDI2 Work Plan Addendum (Anchor QEA 2020b), to further screen two 
locations around PDI-PRB-DP-03, which had levels of fluoride higher than anticipated. A hydraulic 
profile tool (HPT) measured the pressure required to inject a flow of water into the soil as the probe 
was advanced into the subsurface. This injection pressure log is an excellent indicator of formation 
permeability. In addition to measurement of injection pressure, the HPT also measured hydrostatic 
pressure under the zero-flow condition. This allowed for the development of an absolute piezometric 
pressure profile for the log and prediction of the position of the water table. The piezometric profile 
was used to calculate the corrected HPT pressure. These data along with the flow rate were used to 
calculate an estimate of hydraulic conductivity (K) in the saturated formation.  

Borings PDI2-PRB-DP-09 and PDI2-PRB-DP-10 (Figure A1) were advanced using a Geoprobe 
77-series drill rig equipped with the HPT. Ten borings were installed for groundwater sample 
collection, five were installed immediately surrounding PDI2-PRB-DP-09, and five were installed 
immediately surrounding PDI2-PRB-DP-10. A separate boring was installed for each groundwater 
sample depth interval determined as a high hydraulic conductivity area by the HPT during the 
advancement of PDI2-PRB-DP-09 and PDI2-PRB-DP-10 (Table A1). Four-foot stainless steel 
temporary well screens with 0.005-inch slot size were installed using the direct push drill rig. When 
the location of higher hydraulic conductivity was reached, the well screen was opened to the aquifer 
and sampling proceeded as discussed in the fluoride screening SOP (Attachment A1). The direct push 
boring installations were performed by Cascade Environmental under the supervision of Anchor QEA 
staff. Field forms are included in Attachment A2. 

2.1.1 Fluoride Field Screening Process and Results 
During the February and April 2020 investigations, polyethylene tubing was inserted to the midpoint 
or base of the screen, and a peristaltic pump was used to collect a groundwater grab sample through 
a 0.45-micron filter for fluoride field screening. A filtered 10-milliliter aliquot of sample was mixed 
with 10 milliliters of a total ionic strength adjustment buffer (TISAB IV, Ricca Chemical Company), and 
the fluoride concentration was measured with a fluoride ion-selective electrode in accordance with 
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the fluoride screening SOP (Attachment A1). Ion-selective electrode readings were taken in millivolts 
and converted to milligrams per liter using a standard curve. The standard curve was generated daily 
using a series of standards in an appropriate range for the measured concentrations. Water quality 
parameters (pH, specific conductivity, and temperature) were collected with a YSI ProPlus 
multiparameter unit equipped with a flow-through cell. 

Fluoride screening results, water quality parameters, and groundwater sample intervals for both the 
February and April 2020 sampling events are presented in Table A1. 

Table A1  
Summary of Fluoride Concentrations in Groundwater 

Boring ID 

Depth 
Interval 
(feet) Date 

Fluoride 
(ppm) 

pH  
(Standard Unit) 

Specific 
Conductance 

(µS/cm) 
Temperature  

(°C) 

PDI-PRB-DP-01 

0–5 2/10/2020 4.36 6.15 317 10.3 

5–10 2/10/2020 18 6.9 834 11.7 

10–15 2/10/2020 13.6 7.17 759 12.0 

15–20 2/10/2020 3.45 6.83 6,359 12.0 

20–25 2/10/2020 -- -- -- -- 

25–30 2/11/2020 1.44 6.84 1,731 10.0 

PDI-PRB-DP-02 

0–5 2/11/2020 -- -- -- -- 

5–10 2/11/2020 38.8 7.86 496 11.7 

10–15 2/11/2020 1.01 -- -- -- 

15–20 2/11/2020 0.591 -- -- -- 

20–25 2/11/2020 0.848 -- -- -- 

25–30 2/11/2020 0.535 -- -- -- 

PDI-PRB-DP-03 

0–5 2/11/2020 -- -- -- -- 

5–10 2/11/2020 442 -- -- -- 

10–15 2/11/2020 85.8 9.49 2,454 12.0 

15–20 2/11/2020 160 -- -- -- 

20–25 2/12/2020 1.79 6.48 2,529 11.6 

25–30 2/12/2020 1.35 -- -- -- 

PDI-PRB-DP-04 

0–5 2/13/2020 -- -- -- -- 

5–10 2/13/2020 4.57 7 412 10.4 

10–15 2/13/2020 13 9.58 1,805 10.8 

15–20 2/14/2020 137 -- -- -- 

20–25 2/14/2020 174 9.74 13,591 10.2 

25–30 2/14/2020 125 -- -- -- 
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Boring ID 

Depth 
Interval 
(feet) Date 

Fluoride 
(ppm) 

pH  
(Standard Unit) 

Specific 
Conductance 

(µS/cm) 
Temperature  

(°C) 

PDI-PRB-DP-05 

0–5 2/13/2020 -- -- -- -- 

5–10 2/13/2020 1.01 7.06 719 9.5 

10–15 2/13/2020 1.09 7.02 1,986 9.4 

15–20 2/13/2020 0.553 6.61 4,048 10.4 

20–25 2/13/2020 0.362 6.39 1,976 11.4 

25–30 2/13/2020 0.385 6.66 3,105 8.1 

PDI-PRB-DP-06 

0–5 2/12/2020 -- -- -- -- 

5–10 2/12/2020 583 10.4 26,129 12.1 

10–15 2/12/2020 513 -- -- -- 

15–20 2/12/2020 30.1 -- -- -- 

20–25 2/12/2020 68.4 -- -- -- 

25–30 2/12/2020 5.74 -- -- -- 

PDI-PRB-DP-07 

0–5 2/12/2020 -- -- -- -- 

5–10 2/12/2020 0.218 6.76 218 11.1 

10–15 2/12/2020 0.278 6.38 240 11.6 

15–20 2/12/2020 0.389 6.4 573 11.9 

20–25 2/12/2020 0.522 -- -- -- 

25–30 2/12/2020 0.286 6.51 1,157 12.2 

PDI-PRB-DP-08 

0–5 2/12/2020 -- -- -- -- 

5–10 2/12/2020 147 9.83 9,099 10.5 

10–15 2/12/2020 22 -- -- -- 

15–20 2/12/2020 0.960 6.5 1,366 11.0 

20–25 2/12/2020 0.683 6.34 963 9.6 

25–30 2/13/2020 0.624 6.41 959 9.6 

PDI2-PRB-DP-09 

8–9 4/16/2020 16.8 7.98 848 18.9 

14–15 4/16/2020 40.1 9.96 11,689 17.9 

19–20 4/16/2020 209 9.66 19,630 19.5 

24–25 4/16/2020 0.513 6.75 1,106 18.6 

29–30 4/16/2020 1.25 7.86 1,109 NA 
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Boring ID 

Depth 
Interval 
(feet) Date 

Fluoride 
(ppm) 

pH  
(Standard Unit) 

Specific 
Conductance 

(µS/cm) 
Temperature  

(°C) 

PDI2-PRB-DP-10 

13–14 4/15/2020 68.4 9.13 12,143 17.4 

16–17 4/15/2020 111 9.64 19,919 17.2 

19–20 4/16/2020 18.4 6.87 4,748 11.9 

23–24 4/16/2020 1.08 6.23 2,390 11.9 

27–29 4/16/2020 0.751 7.52 1,170 NA 
Notes: 
A stainless-steel screen with a 0.004-inch slot size was used at PDI-PRB-DP-01 and PDI-PRB-DP-02 (1 to 10 feet) but switched to a 
PVC screen with a 0.01-inch slot size to reduce heaving in the core at PDI-PRB-DP-02 (10 to 30 feet) and remaining boring locations. 
Stainless-steel temporary well screens with a 0.005-inch slot size were used for PDI2-PRB-DP-09 and PDI2-PRB-DP-10. 
--: Not enough water was collected to take both fluoride reading and pH, specific conductance, and temperature readings. At least 
250 milliliters is required to fill the YSI flow cell, and these intervals did not have enough water for the YSI flow cell and the fluoride 
sample. See SOP deviation form in Attachment A1. 
 

2.1.2 Soil Cores 
Separate soil borings were advanced at PDI-PRB-DP-04, PDI-PRB-DP-05, and PDI-PRB-DP-08 for 
lithology and collection of samples for grain size analysis. Soil cores were collected in 5-foot intervals 
using the closed-tip method described in Section 3.7.1 of the SAP (Anchor QEA 2019b) with a 2.25-
inch outside diameter core barrel sampler equipped with a 1.5-inch diameter polyvinyl chloride (PVC) 
liner. Upon advancing the closed tip to the top of the target 5-foot sampling interval, the inner rods 
were removed, and the core barrel was advanced into the undisturbed formation to collect a soil 
core. The core barrel was removed from the borehole, and the PVC liner was removed from the core 
barrel, capped, and taken to the Anchor QEA geochemistry laboratory in Portland, Oregon, for 
logging and sample collection for grain size analysis. 

A geologic boring log was created for each soil sampling boring. Each 5-foot soil core interval was 
photographed in 1-foot intervals and described by an Anchor QEA staff geologist in accordance with 
ASTM D2488 – 17e1: Standard Practice for Description and Identification of Soils (Visual-Manual 
Procedure) (ASTM 2017a). A professional archaeologist from AECOM also observed the soil core for 
items of archaeological significance. Soil descriptions included percent recovery, Unified Soil 
Classification System soil type, moisture content, grain size, grading, density/consistency, odor, 
presence of anthropogenic material, and color. Soil descriptions and sample information were 
recorded on a boring log form. Copies of soil boring logs are included in Attachment A3. The 
coarsest and finest soil observed in each soil boring was sampled, and grain size analysis performed 
and used in horizontal hydraulic conductivity estimates for PRB design. 
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2.2 Sonic Borings 
The primary goal of the geotechnical coring program was to collect samples for laboratory testing of soil 
geotechnical properties, including index properties, consolidation, and shear strength properties. 
Geotechnical coring and sample collection were conducted as outlined in the PDI Work Plan and PDI 
Work Plan Addendum (Anchor QEA 2019a, 2020a). The geotechnical investigation occurred between 
February 10 and 25, 2020, and was implemented by Anchor QEA with drilling conducted by Yellow Jacket 
Drilling (YJD). Throughout the investigation, YJD used a Terramac track-mounted sonic oscillator drill rig 
manufactured by Terra Sonic, and a Terramac track-mounted support rig to conduct 6-inch diameter 
roto-sonic core borings to a depth ranging from 41.5 to 62 feet bgs. The investigation included a total of 
21 sonic core borings. These borings included one at SU10 to 41.5 feet bgs, seven borings at SU2 ranging 
from 41.5 to 52 feet bgs, nine borings at SU6 ranging from 50 to 57 feet bgs, and four borings at S07 
ranging from 42 to 62 feet bgs. The locations of these borings can be found in Figure A2, and a summary 
of the boring depths, coordinates, and elevations are provided in Table A2. Field forms are included in 
Attachment A2. 

Table A2  
Summary of Boring Depths, Coordinates, and Elevations 

Station 
ID Test Date 

Coordinates1 
(NAD83, feet) 

Ground 
Surface 

Elevation2 
(NAVD88, 

feet) 

Total 
Depth of 

Sonic 
Core 
(feet) 

Water 
Depth at 
Time of 
Boring  
(feet) 

Water Table 
Elevation at 

Time of Boring 
(NAVD88, 

feet) 
Easting 

(X) 
Northing 

(Y) 

SU02B1 2/12/2020 1003154.00 304876.00 21.0 46.0 7.0 14.0 

SU02B2 2/11 and 
2/12/2020 1003680.96 304694.12 25.7 42.5 -- -- 

SU02B3 2/10 and 
2/11/2020 1004597.00 304405.00 23.6 41.5 15.0 8.6 

SU02B4 2/14/2020 1004480.00 304778.00 15.9 42.0 -- -- 

SU02B5 2/14/2020 1004272.00 305051.00 15.0 42.0 0.0 15.0 

SU02B6 2/13/2020 1003508.00 305061.00 13.4 42.0 5.0 8.4 

SU02B7 2/13/2020 1003611.00 304908.00 22.3 42.0 -- -- 

SU06B1 2/24/2020 1008367.00 302427.00 22.8 50.0 -- -- 

SU06B2 2/22/2020 1008605.00 302704.00 22.4 51.5 -- -- 

SU06B3 2/21/2020 1008845.00 302961.00 22.0 57.0 10.0 12.0 

SU06B4 2/20 and 
2/21/2020 1009068.00 302858.00 22.0 52.0 10.0 12.0 

SU06B5 2/24/2020 1008717.00 302321.00 24.7 52.0 10.0 14.7 

SU06B6 2/21/2020 1008781.39 302606.85 24.4 57.0 10.0 14.4 

SU06B7 2/20/2020 1009142.00 302640.00 22.7 56.0 10.0 12.7 

SU06B8 2/22/2020 1008676.00 302473.83 24.3 53.5 0.0 24.3 
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Station 
ID Test Date 

Coordinates1 
(NAD83, feet) 

Ground 
Surface 

Elevation2 
(NAVD88, 

feet) 

Total 
Depth of 

Sonic 
Core 
(feet) 

Water 
Depth at 
Time of 
Boring  
(feet) 

Water Table 
Elevation at 

Time of Boring 
(NAVD88, 

feet) 
Easting 

(X) 
Northing 

(Y) 

SU06B9 2/19/2020 1008950.04 302747.27 22.3 57.0 10.0 12.3 

SU07B1 2/17/2020 1009265.00 303449.00 11.3 52.0 0.0 11.3 

SU07B2 2/18/2020 1009505.00 302938.00 11.7 42.0 0.0 11.7 

SU07B3 2/18/2020 1009189.00 302980.00 11.5 42.0 0.0 11.5 

SU07B4 2/17 and 
2/18/2020 1009301.93 303178.19 11.5 62.0 0.0 11.5 

SU10B1 2/19/2020 1007141.00 302942.00 31.7 42.5 20.0 11.7 
Notes: 
1. Horizontal datum is North American Datum of 1983, Washington State Plane, feet. 
2. Vertical datum is North American Vertical Datum of 1988, feet. 
--: not observed 
 

Soil processing was completed at the time of drilling, and primarily included the following: 

• Prior to sampling, color photographs were taken of the total sample length. 
• Soil description along the entire length of the core in accordance with ASTM International 

(ASTM) procedures—ASTM D2488 – 17e1: Standard Practice for Description and Identification 
of Soils (Visual-Manual Procedure) (ASTM 2017a) and ASTM D2487 - 17e1: Standard Practice 
for Classification of Soils for Engineering Purposes (Unified Soil Classification System) (ASTM 
2017b)—were recorded, including soil type, moisture content, density/consistency of soil, and 
color. 

• Field vane shear strength tests were performed with a TORVANE, using the following steps in 
accordance with ASTM Method D2573 / D2573M - 18: Standard Test Method for Field Vane 
Shear Test in Saturated Fine-Grained Soils (ASTM 2017c). 

• Pocket penetrometer tests were performed in accordance with ASTM Method D2573 / 
D2573M - 18 (ASTM 2017c). 

• Grab bag soil samples were collected in 1-gallon bags, labeled, stored, and then shipped to 
HWA Geosciences, Inc., for geotechnical laboratory testing. 

2.2.1 Standard Penetration Tests 
Standard penetration test (SPT) samples were collected at 5- to 20-foot depth intervals throughout 
the investigation. The testing intervals and specific blow counts per foot of material (N-value) are 
shown in the boring logs (Attachment A3). These SPTs indicated that the subsurface is generally 
considered very soft to soft, and/or very loose to loose to at least the depth of the individual sonic 
core borings located throughout the site. In addition, TORVANE testing for soil shear strength and 
penetrometer testing for compressive strength were also conducted. 
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2.2.2 Undisturbed Sampling 
Shelby tube samples were collected throughout the investigation at predetermined depths, as well as 
at discrete sampling depths, which were suspected to contain fine-grained materials. Shelby tube 
samples were left in place for approximately 10 to 20 minutes to allow the soil inside the sampler to 
swell, thus improving overall sample recovery. The laboratory results pertaining to the samples 
collected by means of Shelby tube (e.g., unconfined compressions tests, bulk density, and 
consolidation tests) are included in Attachment A4. 

2.3 Direct Push Borings 
The primary goal of the geotechnical coring program was to collect samples for laboratory testing of soil 
geotechnical properties, including index properties. Geotechnical boring and sample collection were 
conducted as outlined in the PDI Work Plan and PDI3 Work Plan Addendum (Anchor QEA 2019a, 2022). 
The geotechnical investigation occurred on February 22 and 23, 2022, and was implemented by 
Anchor QEA with drilling conducted by Cascade Environmental. Throughout the investigation, 
Cascade Environmental used a Geoprobe track-mounted 3230DT drill rig manufactured by Geoprobe. 
The investigation included a total of two direct push borings to a depth ranging from 30.5 to 50 feet bgs. 
These borings were conducted approximately 70 feet southeast of Berth Road (50 feet bgs) and 
approximately 500 feet northwest of Berth Road (30.5 feet bgs). The locations of these borings can be 
found in Figure A2, and a summary of the boring depths, coordinates, and elevations are provided in 
Table A3. Field forms are included in Attachment A2. 

Table A3  
Summary of Boring Depths, Coordinates, and Elevations 

Station 
ID Test Date 

Coordinates1 
(NAD83, feet) 

Ground 
Surface 

Elevation2 
(NAVD88, 

feet) 

Total 
Depth of 

Direct Push 
Boring 
(feet) 

Easting 
(X) 

Northing 
(Y) 

PDI3-B01 2/22 and 
2/23/2022  1008919.67 303086.55 8.7 50 

PDI3-B02 2/23/2022 1008776.88 303191.03 8.8 30.5 
Notes: 
1. Horizontal datum is North American Datum of 1983, Washington State Plane South, feet. 
2. Vertical datum is North American Vertical Datum of 1988, feet. 
 

Soil processing was completed at the time of drilling and primarily included the following: 

• Prior to sampling, color photographs were taken of the total sample length. 
• Soil description along the entire length of the core in accordance with ASTM procedures—

ASTM D2488 – 17e1: Standard Practice for Description and Identification of Soils 
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(Visual-Manual Procedure) (ASTM 2017a) and ASTM D2487 – 17e1: Standard Practice for 
Classification of Soils for Engineering Purposes (Unified Soil Classification System) (ASTM 
2017b)—were recorded, including soil type, moisture content, density/consistency of soil, and 
color. 

• Grab bag soil samples were collected in 1-gallon bags, labeled, stored, and then shipped to 
Materials Testing & Consulting, Inc., for geotechnical laboratory testing. The laboratory results 
are included in Attachment A4. 

2.3.1 Standard Penetration Tests 
SPT samples were collected at intervals ranging from continuous to 10-foot depth intervals 
throughout the investigation. The testing intervals and N-value are shown in the boring logs 
(Attachment A3). These SPTs indicated that the subsurface is generally considered very soft to soft 
and/or very loose to loose to at least the depth of the individual direct push borings located 
throughout the site. 

2.4 In Situ Penetration Testing 
In situ penetration testing was conducted using a CPT probe as outlined in the PDI Work Plan and the PDI 
Work Plan Addendum (Anchor QEA 2019a, 2020a). In situ penetration testing is used to determine 
subsurface lithology correlated to measured soil properties. CPT uses a cone-shaped probe that can be 
instrumented with various sensors to measure tip resistance, friction, porewater pressure, and other 
geotechnical and environmental parameters. The locations of the CPTs can be found in Figure A3, and a 
summary of the boring depths, coordinates, and elevations are provided in Table A4. 

Table A4  
Summary of CPT Depths, Coordinates, and Elevations 

Station ID Test Date 

Actual Coordinates1 
(NAD83, feet) 

Ground 
Surface 

Elevation2 
(NAVD88, 

feet) 

Total 
Depth of 

Direct 
Push 
(feet) 

Water 
Depth at 
Time of 

Test 
(feet) 

Water 
Elevation at 
Time of Test 
(NAVD88, 

feet) 
Easting 

(X) 
Northing 

(Y) 

PRB-PC-01 2/20/2020 1003060.29 306896.56 7.4 40.0 2.5 4.9 

PRB-PC-02 2/20/2020 1003022.25 305342.11 13.8 40.0 7.0 6.8 

SU02-PC-01 2/19/2020 1003686.65 304672.22 26.1 33.1 9.5 16.6 

SU02-PC-01-B 2/19/2020 1003686.65 304672.22 26.1 40.0 9.5 16.6 

SU02-PC-02 2/19/2020 1004243.25 304490.12 27.4 40.0 10.6 16.8 

SU02-PC-03 2/20/2020 1004475.79 304756.12 16.2 40.1 3.9 12.3 

SU02-PC-04 2/20/2020 1003859.67 305063.72 9.1 40.0 3.9 5.2 
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Station ID Test Date 

Actual Coordinates1 
(NAD83, feet) 

Ground 
Surface 

Elevation2 
(NAVD88, 

feet) 

Total 
Depth of 

Direct 
Push 
(feet) 

Water 
Depth at 
Time of 

Test 
(feet) 

Water 
Elevation at 
Time of Test 
(NAVD88, 

feet) 
Easting 

(X) 
Northing 

(Y) 

SU02-PC-05 2/20/2020 1003599.93 304886.93 23.1 50.4 13.9 9.2 

SU06-PC-01 2/21/2020 1008683.23 302491.14 24.3 60.0 3.6 20.7 

SU06-PC-02 2/21/2020 1008745.23 302746.14 21.8 60.1 2.9 18.9 

SU06-PC-03 2/21/2020 1008961.23 302759.14 22.1 60.1 3.7 18.4 

SU06-PC-04 2/21/2020 1009300.23 302780.14 21.5 60.6 10.7 10.8 

SU06-PC-05 2/22/2020 1008915.64 302471.47 25.0 60.2 6.7 18.3 

SU06-PC-06 2/22/2020 1008521.17 302429.21 23.3 60.1 2.9 20.4 

SU07-PC-01 2/22/2020 1008999.00 303149.00 10.5 40.3 0.7 9.8 

SU07-PC-02 2/22/2020 1009460.22 303244.14 11.5 40.9 1.9 9.6 

SU07-PC-03 2/22/2020 1009292.89 303150.43 11.5 50.0 1.1 10.4 

SU10-PC-01 2/19/2020 1006899.24 303023.13 28.4 50.0 16.5 11.9 

SU10-PC-02 2/19/2020 1007330.24 302795.13 30.8 50.0 15.9 14.9 
Notes: 
1. Horizontal datum is North American Datum of 1983, Washington State Plane, feet.   
2. Vertical datum is North American Vertical Datum of 1988, feet. 
 

Reliable equations and relationships have been developed to correlate collected data with 
geotechnical design parameters, such as material type, undrained shear strength (Su), and frictional 
strength, without physically collecting samples or performing laboratory tests (Robertson and Cabal 
2015; Mayne 2014). The various correlations used for in situ data collected are detailed in the 
ConeTec report provided in Attachment A5. Su can be directly estimated from the tip resistance 
measured during advancement of the cone. Tip resistance and pore pressure measurements allow 
for a near-continuous relationship of Su versus depth. Preliminary Su data were calculated by 
ConeTec using a cone resistance factor of 15.0 for CPT data. Strength values derived from these data 
are only valid for materials that consist mainly of fine-grained particles that behave cohesively, as 
defined by Robertson’s soil behavior type chart (Robertson 1990). Cohesionless materials (sand and 
gravel) rely on inter-particle friction to develop strength, and the method used to estimate Su 
considers net tip resistance but neglects sleeve friction.  

Descriptions of the in situ penetration testing collection methods are provided in the following 
subsections, and results are provided in Attachment A5. Stations where in situ data were collected 
are displayed in Figure A2.  
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2.4.1 In Situ Penetration Testing 
CPT was conducted in conjunction with the sonic core borings, at six different locations, to depths 
ranging from 40 to 60 feet bgs. CPT testing was conducted by ConeTec from February 19 to 22, 
2020. CPT results can be found in Attachment A5.  

2.4.2 Pore Pressure Dissipation Testing 
Pore pressure dissipation testing accompanied each CPT. As a CPT cone is pushed into saturated 
sediment/soil, it creates a localized increase in pore pressure as porewater is pushed out of the way 
of the cone. The pore pressure dissipation test involves stopping the downward movement of the 
cone at specified depths, then disconnecting the CPT rods from the CPT rig and allowing porewater 
pressure to dissipate and stabilize. During the test, the changes in porewater pressure are measured 
against time. The rate of dissipation indicates the permeability or hydraulic conductivity of the 
sediment/soil. Results of this testing are presented in Attachment A5. 
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Attachment A1  
Standard Operating Procedures  



 

Standard Operating Procedure 
Former Reynolds Metals 
Reduction Plant – Longview –  
Cone Penetration Testing 



SOP – Longview
Cone Penetration Testing 

Pre-Design Investigation 
Former Reynolds Metals Reduction Plant – Longview 1 August 2020 

1 Standard Operating Procedure Acknowledgement Form 
Project Number: 190730-01.02 Project Name: Former Reynolds Metals Reduction Plant – 

Longview 

My signature below certifies that I have read and understand the procedures specified in this 
Standard Operating Procedure. 

Date Name (print) Signature Company 



2 

Date Name (print) Signature Company 

SOP – Longview
Cone Penetration Testing 

Pre-Design Investigation 
Former Reynolds Metals Reduction Plant – Longview August 2020 
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2 Scope and Application 
This Standard Operating Procedure (SOP) describes the procedures for the collection of cone 
penetration testing (CPT) data as part of the Pre-Design Investigation (PDI) for the Millennium Bulk 
Terminals – Longview, LLC (MBTL) Study Area. Anchor QEA, LLC, has contracted with a specialty CPT 
company to perform the CPT tests and provide technical support for analysis of in situ penetration 
data. The equipment, data collection, and data reduction are in accordance with Appendix A-3-1 and 
the current ASTM International D5778 standard. 

Procedures for CPT data collection in this SOP are expected to be followed. Deviations from the 
procedures detailed in this SOP will be recorded in the Daily Log. 

SOP – Longview
Cone Penetration Testing 

Pre-Design Investigation 
Former Reynolds Metals Reduction Plant – Longview August 2020 
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3 Health and Safety Warnings 
Health and safety issues associated with this SOP, including physical, chemical, and biological 
hazards, are addressed in the Health and Safety Plan (HASP; Anchor QEA 2019a). The HASP will be 
followed during all activities conducted by Anchor QEA personnel as part of the MBTL PDI field work. 
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4 Personnel Qualifications 
Field personnel executing these procedures will have read, be familiar with, and comply with the 
requirements of this SOP, the Pre-Design Investigation Work Plan (Anchor QEA 2019b), and the 
corresponding documents (i.e., Pre-Design Investigation Sampling and Analysis Plan [SAP; 
Anchor QEA 2019c], Pre-Design Investigation Quality Assurance Project Plan [QAPP; 
Anchor QEA 2019d], and HASP). Specialized training for field staff is not required for collection of 
CPT test data; the CPT company subcontracted to perform this work shall be qualified professionals 
who are experienced in performing the tasks required for CPT data collection. 

SOP – Longview
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5 Equipment and Supplies 
The following is a list of equipment that may be necessary to carry out the procedures contained in 
this SOP. Additional equipment may be required, pending field conditions. Possible necessary 
equipment is as follows: 

• Approved documents, including the SAP, QAPP, and HASP
• Appropriate personal protective equipment and clothing as defined in the HASP
• Test location coordinates
• CPT testing rig equipped with necessary differential global positioning system (DGPS)

navigation (minimum overall accuracy of 2 meters) and communication equipment
• Standardized field log forms (field forms) and writing appurtenances
• Tape measure

SOP – Longview
Cone Penetration Testing 
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6 Procedures 
CPT testing will be performed using a CPT rig at locations described in the SAP. 

CPT will be performed using the following procedures: 

1. The CPT testing rig will be driven to the proposed location.
2. The location will be recorded on the appropriate forms by the location control personnel.
3. CPT will be performed to the designated depth and in general accordance with the current

version of ASTM D5788 and in accordance with the subcontractor’s SOPs.
4. The depth of the test will be measured and recorded.

SOP – Longview
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7 Quality Assurance/Quality Control 
Quality control procedures will consist of following standard instrument operation procedures and 
filling out field check forms. Entries in the field forms will be double-checked by the field team staff 
to verify the information is correct. It is the responsibility of the Field Lead to periodically check to 
ensure the procedures are in conformance with those stated in this SOP. 
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Appendix A-3-1 
ConeTec Cone Penetration Test 
Information 



CONE PENETRATION TEST 

The cone penetration tests (CPTu) are conducted using an integrated electronic piezocone penetrometer 
and data acquisition system manufactured by Adara Systems Ltd. of Richmond, British Columbia, Canada.  

ConeTec’s piezocone penetrometers are compression type designs  in which the tip and  friction sleeve 
load cells are independent and have separate load capacities.  The piezocones use strain gauged load cells 
for tip and sleeve friction and a strain gauged diaphragm type transducer for recording pore pressure.  
The piezocones also have a platinum resistive temperature device (RTD) for monitoring the temperature 
of the sensors, an accelerometer type dual axis inclinometer and a geophone sensor for recording seismic 
signals.  All signals are amplified down hole within the cone body and the analog signals are sent to the 
surface through a shielded cable.   

ConeTec penetrometers are manufactured with various tip, friction and pore pressure capacities in both 
10 cm2 and 15 cm2  tip base area configurations  in order  to maximize signal resolution  for various soil 
conditions.   The 15 cm2 penetrometers do not require friction reducers as they have a diameter  larger 
than  the deployment  rods.   The 10 cm2 piezocones use a  friction  reducer consisting of a  rod adapter 
extension behind the main cone body with an enlarged cross sectional area (typically 44 mm diameter 
over a length of 32 mm with tapered leading and trailing edges) located at a distance of 585 mm above 
the cone tip.  

The penetrometers are designed with equal end area friction sleeves, a net end area ratio of 0.8 and cone 
tips with a 60 degree apex angle. 

All ConeTec piezocones can record pore pressure at various locations.  Unless otherwise noted, the pore 
pressure filter is located directly behind the cone tip in the “u2” position (ASTM Type 2).  The filter is 6 mm 
thick, made of porous plastic (polyethylene) having an average pore size of 125 microns (90‐160 microns).  
The function of the filter  is to allow rapid movements of extremely small volumes of water needed to 
activate the pressure transducer while preventing soil ingress or blockage.   

The piezocone penetrometers are manufactured with dimensions, tolerances and sensor characteristics 
that are in general accordance with the current ASTM D5778 standard.   ConeTec’s calibration criteria also 
meet or exceed those of the current ASTM D5778 standard.  An illustration of the piezocone penetrometer 
is presented in Figure CPTu. 



CONE PENETRATION TEST 

Figure CPTu. Piezocone Penetrometer (15 cm2) 

The ConeTec data acquisition systems consist of a Windows based computer and a signal conditioner and 
power  supply  interface box with  a  16 bit  (or  greater)  analog  to digital  (A/D)  converter.    The data  is 
recorded at fixed depth increments using a depth wheel attached to the push cylinders or by using a spring 
loaded rubber depth wheel that is held against the cone rods. The typical recording intervals are either 
2.5 cm or 5.0 cm depending on project requirements; custom recording intervals are possible.  The system 
displays  the CPTu data  in  real  time  and  records  the  following parameters  to  a  storage media during 
penetration:   

 Depth

 Uncorrected tip resistance (qc)

 Sleeve friction (fs)

 Dynamic pore pressure (u)

 Additional  sensors  such  as  resistivity,  passive  gamma,  ultra  violet  induced  fluorescence,  if
applicable

All  testing  is  performed  in  accordance  to  ConeTec’s  CPT  operating  procedures which  are  in  general 
accordance with the current ASTM D5778 standard. 



CONE PENETRATION TEST 

Prior to the start of a CPTu sounding a suitable cone is selected, the cone and data acquisition system are 
powered on, the pore pressure system  is saturated with either glycerin or silicone oil and the baseline 
readings are recorded with the cone hanging freely in a vertical position. 

The CPTu is conducted at a steady rate of 2 cm/s, within acceptable tolerances.  Typically one meter length 
rods with an outer diameter of 1.5  inches are added to advance the cone to the sounding termination 
depth.  After cone retraction final baselines are recorded.   

Additional information pertaining to ConeTec’s cone penetration testing procedures: 

 Each filter is saturated in silicone oil or glycerin under vacuum pressure prior to use

 Recorded baselines are checked with an independent multi‐meter

 Baseline readings are compared to previous readings

 Soundings  are  terminated  at  the  client’s  target depth or  at  a  depth where  an obstruction  is
encountered, excessive rod flex occurs, excessive inclination occurs, equipment damage is likely
to take place, or a dangerous working environment arises

 Differences between initial and final baselines are calculated to ensure zero load offsets have not
occurred and to ensure compliance with ASTM standards

The interpretation of piezocone data for this report is based on the corrected tip resistance (qt), sleeve 
friction  (fs) and pore water pressure  (u).   The  interpretation of  soil  type  is based on  the  correlations 
developed by Robertson (1990) and Robertson (2009).  It should be noted that it is not always possible to 
accurately identify a soil type based on these parameters.  In these situations, experience, judgment and 
an assessment of other parameters may be used to infer soil behavior type.   

The recorded tip resistance (qc) is the total force acting on the piezocone tip divided by its base area.  The 
tip resistance is corrected for pore pressure effects and termed corrected tip resistance (qt) according to 
the following expression presented in Robertson et al, 1986:  

qt = qc + (1‐a) • u2 

where:  qt is the corrected tip resistance 
qc is the recorded tip resistance 
u2 is the recorded dynamic pore pressure behind the tip (u2 position) 
a is the Net Area Ratio for the piezocone (0.8 for ConeTec probes) 

The sleeve  friction  (fs)  is  the  frictional  force on  the sleeve divided by  its surface area.   As all ConeTec 
piezocones have equal end area  friction sleeves, pore pressure corrections  to  the sleeve data are not 
required.   

The dynamic pore pressure (u) is a measure of the pore pressures generated during cone penetration.  To 
record equilibrium pore pressure, the penetration must be stopped to allow the dynamic pore pressures 
to stabilize.  The rate at which this occurs is predominantly a function of the permeability of the soil and 
the diameter of the cone. 

The  friction  ratio  (Rf)  is a  calculated parameter.  It  is defined as  the  ratio of  sleeve  friction  to  the  tip 
resistance expressed as a percentage.   Generally, saturated cohesive soils have low tip resistance, high 



CONE PENETRATION TEST 

friction  ratios  and  generate  large  excess  pore  water  pressures.    Cohesionless  soils  have  higher  tip 
resistances, lower friction ratios and do not generate significant excess pore water pressure.  

A  summary  of  the  CPTu  soundings  along with  test  details  and  individual  plots  are  provided  in  the 
appendices.    A  set  of  interpretation  files  were  generated  for  each  sounding  based  on  published 
correlations  and  are  provided  in  Excel  format  in  the  data  release  folder.    Information  regarding  the 
interpretation methods used is included in an appendix.   

For additional information on CPTu interpretations, refer to Robertson et al. (1986), Lunne et al. (1997), 
Robertson (2009), Mayne (2013, 2014) and Mayne and Peuchen (2012). 
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1 Scope and Application 
This Standard Operating Procedure (SOP) describes the procedures for the collection and processing 
of soil boring data as part of the Pre-Design Investigation Sampling and Analysis FSAP 
 for the Former Reynolds Metals Reduction Plant – Longview project. Samples from upland 
geotechnical borings will be collected for visual description and geotechnical testing.  

Specific information regarding data collection and the list of parameters for soil analyses can be 
found in the Pre-Design Investigation Field Sampling and Analysis Plan (FSAP) and the Pre-Design 
Investigation Quality Assurance Project Plan (QAPP). 

Procedures for soil sample collection in this SOP are expected to be followed. Substantive deviations 
from the procedures detailed in this SOP will be recorded on the Daily Log. 

2 Health and Safety Warnings 
Health and safety issues associated with this SOP, including physical, chemical, and biological 
hazards, are addressed in the Pre-Design Investigation Health and Safety Plan (HASP). The HASP will 
be followed during all activities conducted by Anchor QEA, LLC personnel as part of the Former 
Reynolds Metals Reduction Plant – Longview Soil project. 

3 Personnel Qualifications 
Field personnel executing these procedures will have read, be familiar with, and comply with the 
requirements of this SOP, the Pre-Design Investigation Work Plan, and the corresponding documents 
(i.e., FSAP, QAPP, and HASP). All field personnel are required to take a 40-hour Occupational Safety 
and Health Administration Hazardous Waste Operations and Emergency Response training course 
and annual refresher course, as well as participate in a medical monitoring program, prior to sample 
collection activities. Additionally, field personnel will be under the direct supervision of qualified 
professionals who are experienced in performing the tasks required for sample collection. 

4 Equipment and Supplies 
The following is a list of equipment that may be necessary to carry out the procedures contained in 
this SOP. Additional equipment may be required, pending field conditions. 

• Approved documents, including the FSAP, QAPP, and HASP 
• Appropriate personal protective equipment (PPE) and clothing as defined in the HASP  
• Decontamination equipment described in section 4 of the SOP – Field Documentation, 

Sample Handling Procedures, Decontamination Procedures, and Investigation-Derived Waste 
Management 

• Standardized field log forms (field forms) 
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• Boring Log and Physical Description of Soil Key forms (see examples provided in Attachments 
1 and 2, respectively) 

• Pocket penetrometer 
• Torvane 
• Black ballpoint pen or Sharpie permanent marker (or equivalent) 
• White board and pens 
• Field laptop computer with Anchor QEA’s Field Scribe and Microsoft Excel 
• Vehicle capable of transporting drilling equipment, including the necessary navigational and 

communication equipment 
• Direct-push (Geoprobe or similar) drill rig or sonic drill, probe rods, and core liner (supplied by 

subcontractor) 
• Standard penetration testing (SPT) equipment (provided by the subcontractor) 
• Differential global positioning system (DGPS) device 
• Photoionization detector (PID) 
• Distilled water 
• Tape measure 
• Electrical or duct tape 
• Paper towels 
• Digital camera 

5 Procedures 
The following descriptions of procedures will be followed for the data collection activities described 
in the FSAP. 

5.1 Soil Boring  
The following general activities and sampling procedures will be implemented for soil boring and 
geotechnical testing in the upland areas.  

Prior to deployment, the following procedures will be used to decontaminate sample tubes: 

1. Rinse and pre-clean Shelby tubes with potable water. 
2. Wash and scrub the core barrel in a solution of phosphate-free soap (e.g., Alconox) and potable 

water. 
3. Rinse with distilled water. 
4. Seal both ends of each Shelby tube with a tube cap or aluminum foil. 
5. If using thin plastic sleeves, store in a decontaminated container until use and decontaminate 

the core barrel casing before each use. 
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The caps will be removed immediately prior to placement onto the rods. Care will be taken during 
sampling to avoid contact of the sample tube with potentially contaminated surfaces.  

Upland soil sample collection will be performed using the following procedures: 

1. The drilling equipment will be maneuvered to the proposed sample location, and the location 
will be recorded using a DGPS-capable device.  

2. Safety checks will be made at the beginning of the day, including arranging all winch cables and 
checking for kinks or burrs, checking the drill rig for fluid leaks, and checking that all “kill” 
switches are operational. 

3. The stabilizers will be lowered, and the drill rig tower will be raised and secured with safety pins 
and bolts.  

4. Before each use, the core barrel will be rinsed and a scrub brush will be used to remove any 
visible soil on the interior of the barrel. 

5. Sonic flights will be advanced to the predetermined sampling depth. If initial sampling is to 
occur at the ground surface, do not advance casing until initial sample is obtained.  

6. A decontaminated core barrel or 2.5-foot Shelby tube will be secured to the sampling rods.  
7. The core barrel or Shelby tube will be driven to the appropriate termination depth. Samplers 

shall be advanced using one of the following methods: 
a. Soil collection using a core barrel: 

i. The core catcher will be inserted, if needed. The core barrel with drill shoe will be 
attached to the drill rod, and the cutting head will be attached to the core barrel 
and lowered. 

ii. The core barrel will be sonic-driven into the soil in 5- or 10-foot sections 
depending on the sonic drilling rig capacity. 

iii. The depth of core penetration will be measured and recorded. 
iv. The cutting bit and core catcher will be removed.   
v. The soil sample will carefully be extruded from the core barrel into the plastic 

sleeve.  
b. Undisturbed soil collection using a Shelby tube: 

i. The Shelby tube will be advanced 24 inches from the initial undisturbed sampling 
depth.  

ii. Vibration will be kept to a minimum when advancing undisturbed samples. 
iii. Allow the Shelby tube to sit for 5 minutes to allow the sample to settle before 

retrieving the sample.  
iv. The depth of sample penetration will be measured and recorded. 
v. Immediately upon retrieval of the Shelby tube, the bottom of the tube will be 

capped. The cap will be secured with duct or electrical tape. 
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vi. The Shelby tube sample will be evaluated at the top of the tube; the length of 
recovered soil will be recorded; and the top of the tube will be secured with a core 
cap and wrapped in duct tape. The tube will be labeled with the sample station 
number, depth interval, and an arrow pointing to the top of core. The Shelby tube 
will be stored upright to preserve core soil integrity and kept at 4°C, plus or minus 
2°C, until shipment. Shelby tubes will be shipped upright with ample padding and 
protection to the contracted laboratory for processing and testing.  

c. Acceptance criteria for soil intervals and Shelby tube samples are as follows: 
(i) The surface is intact. 
(ii) The tube appears intact without obstruction or blocking. 
(iii) Recovery is greater than 50% of drive length. 

8. If sample acceptance criteria are not achieved, the sample is rejected unless modified 
acceptance criteria are approved by the Field Team Leader following consultation with the U.S. 
Environmental Protection Agency and/or multiple attempts have been made at the sampling 
location. 

Anchor QEA personnel will record field conditions and drive notes on the Boring Logs (see 
Attachment 1). The logs will include the following information: 

• The sample station identification 
• Drilling method 
• Geographic position of the actual coring location as determined by DGPS  
• Date and time of collection of each soil core sample 
• Names of field personnel collecting and handling the samples 
• Observations made during sample collection, including weather conditions, complications, 

and other details associated with the sampling effort 
• Length of drive penetration and estimated recovery measurements  
• Qualitative notation of apparent resistance of soil column to coring (how the core drove) 

6 Soil Processing 
1. Sample processing will be conducted at the drilling site after retrieval of the boring.  
2. Sample processing consists of opening up the thin plastic sleeve to access the soil. 
3. Disposable gloves will be discarded after processing at each station and replaced prior to 

handling instruments or work surfaces. 
4. The sample will be split to expose the center of the two halves for visual observations.  
5. Prior to sampling, color photographs will be taken of the total sample length.  
6. A description of the sample will be recorded on the Boring Log (see example provided in 

Attachment 1) for the following parameters as appropriate: 
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a. Date and time of sample collection 
b. Sample recovery (depth in feet of penetration compared to recovery) 
c. Physical soil description along the entire length of the core in accordance with ASTM 

International (ASTM) procedures—ASTM D2488 – Standard Practice for Description and 
Identification of Soils (Visual-Manual Procedure) and ASTM D2487 – Standard Practice for 
Classification of Soils for Engineering Purposes (Unified Soil Classification System)—will be 
recorded including soil type, moisture content, density/consistency of soil, and color 

d. Odors (e.g., hydrogen sulfide or petroleum) 
e. Visual stratification, structure, and texture 
f. Visual evidence of impacts (e.g., sheens) and potential nonaqueous phase liquid 
g. Vegetation and debris 
h. PID readings 
i. Biological activity (e.g., detritus, shells, tubes, bioturbation, and live or dead organisms) 
j. Presence of sheen 
k. Any other distinguishing characteristics or features 

7. If required, a field vane shear strength test will be performed with a Torvane, using the following 
steps in accordance with ASTM Method D2573 – Standard Test Method for Field Vane Shear 
Test in Saturated Fine-Grained Soils: 

a. Find a representative section of sample for testing within the target sampling. 
b. Set the Torvane to zero according to the manufacturer’s instructions. 
c. Push the Torvane into the soil. 
d. Begin turning the vane at a rate of 1 degree per 6 minutes until failure is observed while 

maintaining a constant angle and pressure. 
e. Upon failure of the sample, record the peak value in the Boring Log (Attachment 1) 

without changing the position of the testing assembly. Also record any anomalies such as 
an unsmooth failure or presence of debris (e.g., anthropogenic material or debris, wood 
pieces, shells). 

f. Rotate the assembly five revolutions to create a residual condition of the failure mass. 
g. Reperform Steps b. through f. and record the results. 
h. Upon completion of the test, remove the sample within the Torvane and set to zero 

before conducting another test.  
8. The pocket penetrometer test will be performed using the following steps in accordance with 

ASTM Method D2573 – Standard Test Method for Field Vane Shear Test in Saturated Fine-
Grained Soils: 

a. Find a representative section of soil for testing within the target sampling interval of the 
Lexan tube or plastic sleeve. 

b. Set the pocket penetrometer to zero according to the manufacturer’s instructions.  
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c. Hold the penetrometer at a right angle against the soil surface, then push the device into 
the soil until it reaches the indicator line. 

d. Remove the penetrometer and record the result in the Boring Log (Attachment 1).  
e. Remove the soil adhered to the penetrometer and set to zero before conducting another 

test.  

7 Quality Assurance/Quality Control 
Quality control procedures will consist of following standard instrument operation procedures for 
collecting soil. Entries in the field forms will be double-checked by the field team staff to verify the 
information is correct. It is the responsibility of the Field Team Leader to periodically check to ensure 
the procedures are in conformance with those stated in this SOP. 

8 List of Attachments 
Attachment 1 – Boring Log 
Attachment 2 – Physical Description of Soil Key  
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1 Introduction 
Groundwater samples for fluoride screening may be collected with direct push drilling techniques 
with either a dual-tube or closed-tip method of borehole advancement.  

The closed-tip method consists of advancing a 4-foot-long retractable screen into undisturbed 
formation to the desired sampling depth. The screen is secured within a small-diameter drive pipe 
with an expendable drive point. The drive pipe is advanced with drill rods to the desired sampling 
depth with the direct push rig. When the desired sample depth is reached, the screen is opened to 
the aquifer by pulling the drill rods up 4 feet. The expendable drive point remains lodged in the soil, 
allowing the screened interval to be exposed to the aquifer.  

The dual-tube method consists of the simultaneous advancement of an outer casing and an inner 
5-foot-long core barrel equipped with a disposable inner plastic liner into the subsurface in 5-foot 
increments. After advancing the assembly 5 feet, the core barrel is withdrawn from inside the outer 
casing, and the plastic liner containing the soil sample is removed from the core barrel. The plastic 
liner is cut lengthwise to expose the soil sample. The above procedure is repeated until the target 
depth of the boring is reached. The outer casing helps seal off upper geologic units and water 
bearing zones, keeps the borehole open, and allows for easy insertion and removal of sampling 
equipment.  

Fluoride screening samples can be collected with the dual-tube method by installing a temporary 
polyvinyl chloride (PVC) well inside the outer casing and lifting the outer casing to expose the 
screened interval to the aquifer.  

A drilling contractor licensed in the state of Washington will be responsible for advancing the soil 
borings to the required depth. An Anchor QEA, LLC geologist licensed in the state of Washington or 
working under the direct supervision of a Washington-licensed geologist will be responsible for 
supervision of drilling activities and collection of groundwater samples as necessary.  

The following sections outline the necessary equipment and the general procedures for collection of 
direct push groundwater samples. 

1.1 Minimum Equipment Checklist 
• Standard personal protective equipment per project-specific health and safety plan (HASP) 
• Decontamination equipment (distilled water, phosphate-free detergent [e.g., Liquinox], 

brushes, water sprayers, paper towels, drying racks, aluminum foil) 
• GPS device  
• Site map with proposed boring locations and coordinates 
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• Peristaltic pump or small-diameter Waterra tubing with check valve (depending on 
depth­to­water conditions) 

• 12-volt battery (if using peristaltic pump) 
• 0.45-micron in-line filters 
• Water quality meter 
• Flexible tubing (Masterflex or similar) 1/4-inch outside diameter polyethylene tubing (if using 

peristaltic pump) 
• Depth-to-water indicator 
• Sampling and analysis plan and HASP 
• Table 
• Plastic sheeting to cover table 
• Sample bottles 
• Sample labels 
• Daily log forms 
• Field screening data measurement form 

1.2 Groundwater Sample Collection Procedures for Fluoride Field 
Screening  

The following general activities and sampling procedures will be implemented for field screening for 
fluoride in groundwater: 

1. Ensure the drilling contractor has positioned the drill rig on the proposed sampling location 
(within 3 meters) using a GPS navigation device. 

2. Collect groundwater samples for fluoride field screening from temporary monitoring wells 
installed in 5-foot intervals in the borehole. 

3. Upon reaching the field screening sample target depth, lift the drill rods (or the outer casing if 
using the dual casing method) 4 feet to expose the screen to the formation. 

4. Use a depth-to-water indicator to determine the static depth to water and the depth to bottom 
of the temporary well from the top of the drill pipe. If after 5 minutes no water has collected in 
the temporary well, remove the screen from the borehole, advance the boring 5 feet, and install 
another screen in the borehole. 

5. The type of pump used for purging will vary depending on the depth to water from the top of 
the drill rods. If the depth to water from the top of the drill rods is less than 27 feet, use a 
peristaltic pump. If the depth to water from the top of the well casing is greater than 27 feet, use 
a hand-actuated Waterra inertial pump with dedicated Waterra tubing and check-valve. 

6. Install polyethylene tubing (if using a peristaltic pump) or Waterra tubing (if using an inertial 
pump) to the midpoint of the screened interval. Begin purging groundwater.  
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7. Immediately begin collecting the groundwater sample for fluoride field screening and 
groundwater quality parameters into a dedicated or decontaminated container. Filter the sample 
with a 0.45-micron filter.  

8. Record groundwater field parameters (pH, conductivity, temperature,) with a YSI Professional 
Plus or similar instrument from the filtered groundwater sample and record on a Field Screening 
Data Measurement Form (Attachment 1). 

9. Measure dissolved fluoride concentration in groundwater sample using a Synaptic Sensors 
fluoride ion selective electrode (ISE) for LabNavigators or similar, and record value on a Fluoride 
Field Screening Measurement Form. The ISE manual is attached to this SOP (Attachment 2).  

10. After field screening is complete, remove and dispose of polyethylene tubing. 
11. Advance the boring 5 feet to the next fluoride field screening interval. 
12. Repeat steps 3 through 11 until the target depth of the boring is obtained or refusal occurs. 
13. Between sample intervals, decontaminate all non-disposable materials used to collect field 

screening samples. 
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Boring ID:       ___________________

Date:_______________________
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pH
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Specific 
Conductance 

(µS/cm)
Temperature

(°C) Notes



 

 

 

Attachment 2  
Fluoride Electrode Instruction Manual and 
Forston Labs LabNavigator 2 Reference 
Guide 



Required Equipment 
 Ion meter or pH/mV meter. 

 Wash bottle with distilled or deionized water. 

 Several clean beakers. 

 1 mL, 10 mL and 100 mL pipettes. 

 4-cycle semilogarithmic paper for calibration curves. 

 Reference Electrode for mono-model. A Reference 
Electrode is not required with the Combination Model 
electrodes.

Required Solutions 
 1000 ppmF- Standard (SD0FL2) 

 Total Ionic Strength Adjuster with CDTA (AJ0FL1) 

 Reference Fill Solution—For FastFil (refillable) 
combination and mono-electrodes (RF0FL1) 

Electrode Preparation 
1. Remove the protective cap covering the electrode tip. 

Caution: Do not touch the sensing element with 
your fingers.

2. Mono (Model 01)—the Reference Electrode must be 
prepared as described in the Reference Electrode 
Instruction Manual. Fill the Reference Electrode with 
Reference Fill Solution. 

3. FastFil (refillable) Combination (Model 44)—the 
reference (outer) chamber must be filled with 
Reference Fill Solution and remain open during testing: 

a. Slide the sleeve of the electrode FastFil cap down 
to uncover the fill holes (see fig. 1).

b. Fill the reference chamber with the Reference Fill 
Solution provided. 

c. Shake the electrode downwards like a thermometer 
to remove any air bubbles trapped inside. 

d. The surface of the Reference Fill Solution in the 
reference chamber must be above the inner 
junction. This is approximately 3" from the 
electrode tip. 

4. PermaFil (non-refillable) Combination (Model 43)— 
the reference chamber is gel filled and sealed. No 
Reference Fill Solution is required. 

5. Rinse the electrode with Dl water, blot dry. Do not rub 
dry. 

6. Place the electrode in the electrode holder. Immerse 
the tip of the electrode in Dl water and stir the water for 
5 minutes. This will properly clean the electrode. 

Checking Electrode Operation (Slope)
1. Connect electrode to the meter. (For Mono-model, also 

connect Reference Electrode to meter.) 

2. Place 50 mL Dl water into a 150 mL beaker. Add 50 
mL TISAB to the Dl water and stir thoroughly. 

3. Set the function switch to the mV mode. 

4. Rinse the electrode with Dl water, blot dry and place in 
the solution prepared in step 2. (For Mono, also rinse 
and place Reference Electrode in the solution.) 

5. Pipet 1 mL of 1000 ppm F~ Standard into the beaker. 
Stir thoroughly, then record the potential (E1) in mV 
when a stable reading is displayed. 

6. Pipette 10 mL of the same standard into the same 
beaker. Stir thoroughly. When a stable reading is 
displayed, record the potential (E2) in mV. 

7. The difference between the first and the second 
potential readings (E1-E2) is defined as the electrode 
slope. The normal range for the slope is 56±4 mV at 
25°C.

Troubleshooting 
If the electrode slope is not within the normal range, the 
following procedure may restore the electrode. 

1. Polish the electrode sensing element with the furnished 
polishing strips. Caution: Do not touch the sensing 
element with your fingers.

2. Rinse and soak the electrode in standard solution for 
about 5 minutes before use. 

3. Repeat "Checking Electrode Operation" procedure 
again. Note: All standard solutions should be prepared 
fresh. You must use TISAB. 

Periodically check the Reference Fill Solution level in the 
reference chamber of the FastFil. The solution level must 
be higher than the inner junction. This step is unnecessary 
with the Mono and PermaFil models. 

If the electrode slope is still outside the normal range after 
this procedure, please contact manufacturer's technical 
service department. 

Reading a Sample with the Electrode 
Various procedures may be used to determine the 
concentration of a sample. The most common is the Direct 
Calibration method, which is described below. Contact 
manufacturer's technical service department for details of 
other methods. 

In Direct Calibration a series of standard solutions of 
differing concentrations are used to calibrate the electrode. 
Then each sample requires only a single meter reading, 
which is compared with the calibration readings to obtain 
the sample concentration. TISAB is added to all solutions 
to ensure the samples and the standards have the same 
ionic strength. 

Setup:
1. Prepare the electrode as described in "Electrode 

Preparation" and "Checking Electrode Operation". 
2. Connect the electrode to the meter. 

3. Prepare two standard solutions that differ in concen-
tration by a factor of ten (or follow meter manufacturers 
instructions) and bracket the expected sample 
concentration range. Use the concentration unit that is 
most appropriate. The standards should be at the 
same temperature as the sample. 

Measurement:
If using a meter with direct concentration reading capability 
(see individual meter instruction manuals for more specific 
information):

1. Place 50 mL of the more dilute standard into a 

1. 150 mL beaker. Add 50 mL of TISAB. Stir thoroughly. 

2. Rinse electrode with Dl water, blot dry and place in the 
beaker. Wait for a stable reading, then adjust the meter 
to display the value of the standard. Refer to the 
meter's instruction manual for the meter adjustment 
procedure.

3. Measure 50 mL of the more concentrated standard into 
a second 150 mL beaker. Add 50 mL of TISAB and stir. 

4. Rinse electrode with Dl water, blot dry and place in the 
second beaker. Wait for a stable reading, then adjust 
the meter to display the value of the second standard. 

5. Pipette 50 mL of sample into a 150 mL beaker. Add 50 
mL of TISAB. Stir thoroughly. 

6. Rinse electrode with Dl water, blot dry and place in the 
sample beaker. Wait for a stable reading and the 
sample concentration will be displayed on the meter. 

If using a meter with millivolt reading only: 

1. Turn the function switch to mV range. 

2. Place 50 mL of the more dilute standard into a 

1. 150 mL beaker. Add 50 mL of TISAB. Stir thoroughly. 

2. Rinse electrode with Dl water, blot dry and place in the 
beaker. Wait for a stable reading, then record the mV 
value and the corresponding standard concentration. 

3. Measure 50 mL of the more concentrated standard into 
a second 150 mL beaker. Add 50 mL of TISAB and stir. 

4. Rinse electrode with Dl water, blot dry and place in the 
second beaker. Wait for a stable reading, then record 
this mV value with the corresponding concentration. 

5. Using the semilogarithmic graph paper, prepare a cali-
bration curve by plotting the mV values on the linear 
axis and the standard concentrations on the logarithmic 
axis.

6. Pipette 50 mL of sample into a 150 mL beaker. Add 50 
mL of TISAB. Stir thoroughly. 

7. Rinse electrode with Dl water, blot dry and place in the 
sample beaker. Wait for a stable reading and record 
the mV reading. 

8. Determine the sample concentration using the 
calibration curve prepared in Step 6 above. 

Electrode Storage 
Short Term (over night or the weekend): 

Rinse the electrode throughly with Dl water and place 
the tip in a solution of 50 mL of TISAB in 50 mL of Dl 
water. For FastFil model slide the sleeve up to close 
refill holes. 

Long Term: 
Mono-electrode and PermaFil (gell filled)—rinse 
throughly with Dl water and store dry. Replace the cap 
to protect the sensing element. 

FastFil Combination—empty reference chamber of 
Reference Fill Solution. Flush reference chamber with 
Dl water several times. Empty Dl water from reference 
chamber and store the electrode-dry. Replace the cap 
to protect the -sensing element. 

Follow procedures in "Electrode Preparation" and 
"Checking Electrode Operation" before using the 
electrode again. 

Specification 
Concentration Range: Saturated to 1 x 10-6 M

(saturated-0.02 ppm) 

pH Range:  5 to 7 pH at 1 x 10-6 M
5 to 11 pH at saturated 

Temperature Range: 0 to 80"C continuous, 80 to  
 100°C intermittent 

Electrode Resistance: less than 50 megohms 

Reproducibility:  ±2% 

Minimum Sample Size: 5 mL in a 50 mL beaker 

Size: Electrode length—155 mm  
Body Diameter—12 mm  
Cap Diameter—16 mm  
Cable Length—100 cm 

Contents 
Fluoride Electrode  1 ea. 

Polishing Strip (MD0004)  2 ea. 

1000ppm as F- (SD2020)  1 oz. 

TISAB with CDTA (AJ0009) 2 oz. 

Reference Fill Solution (RF0007)  1 oz. 
(Mono models only) 
Polygen Reference Fill Solution (RF0007P) 1 oz. 

(FastFil models only) 
Plastic Pipette Instruction Manual (ISE4010-C00) 1 ea. 



FastFil Cap (fig. 1) 

Laboratory Products Warranty 

Products designed and sold for use in laboratory 
applications are warranted to be free from defects in 
materials and workmanship for a period of six (6) months, 
provided that the product is used in accordance with the 
instructions provided and that the product has not been 
subjected to breakage, alteration, misuse, abuse or used in 
an application not normally intended for the product. In the 
event of a warranted failure within the warranty period, 
contact your supplier. 

Please be prepared to discuss the details of the difficulty. If 
necessary, your supplier will issue a Return Authorization 
Number (RAN). Materials or goods returned without an 
RAN will not be accepted. Return the product to your 
supplier freight prepaid. 

The warranty described above is exclusive and in lieu 
of all other warranties whether statutory, express or 
implied including, but not limited to, any implied 
warranty of merchantability or fitness for a particular 
purpose and all warranties arising from the course of 
dealing or usage of trade. The buyer's sole and 
exclusive remedy is for repair or replacement of the 
non-conforming product or part thereof, but in no 
event shall ASI or it's dealers or agents of any tier be 
liable to the buyer or any person (or any special, 
indirect, incidental or consequential damages whether 
the claims are based in contract in tort (including 
negligence) or otherwise with respect to or arising out 
of the product furnished hereunder.

ISE4010-C00

The Fluoride Electrode is a 
hand crafted solid state ion-
selective electrode which 
measures total free fluoride 
in aqueous solutions 
simply, quickly, 
economically, and 
accurately.

If you have the mono-
model fluoride electrode, 
then you also need a 
reference electrode. 

Carefully follow the direc-
tions on this instruction 
sheet to obtain the best 
performance and electrode 
life.F
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SAFETY INFORMATION 
Federal Communication Commission Interference Statement 
This equipment has been tested and found to comply with the limits for a Class B digital device, 
pursuant to Part 15 of the FCC rules. These limits are designed to provide reasonable protection 
against harmful interference in a residential installation. This equipment generates, uses and can 
radiate radio frequency energy and, if not installed and used in accordance with the instructions, 
may cause harmful interference to radio communications. However, there is no guarantee that 
interference will not occur in a particular installation. If this equipment does cause harmful 
interference to radio or television reception, which can be determined by turning the equipment 
off and on, the user is encouraged to try to correct the interference by one or more of the 
following measures: 

 Reorient or relocate the receiving antenna.  
 Increase the separation between the equipment and receiver.  
 Connect the equipment into an outlet on a circuit different from that to which the receiver 

is connected.  
 Consult the dealer or an experienced radio/TV technician for help.  

 
FCC Caution 
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two 
conditions:  

(1) this device may not cause harmful interference and  

(2) this device must accept any interference received, including interference that may cause 
undesired operation  

RF Exposure Warning 
The equipment complies with RF exposure limits set forth for an uncontrolled environment. The 
antenna(s) used for this transmitter must not be co-located or operating in conjunction with any 
other antenna or transmitter.   

You are cautioned that changes or modifications not expressly approved by the party responsible 
for compliance could void your authority to operate the equipment. 

 
IC Statement 
This device complies with Industry Canada license-exempt RSS standard(s). Operation is subject 
to the following two conditions: (1) this device may not cause interference, and (2) this device 
must accept any interference, including interference that may cause undesired operation of the 
device. 

Industry Canada - Class B This digital apparatus does not exceed the Class B limits for radio 
noise emissions from digital apparatus as set out in the interference-causing equipment standard 
entitled “Digital Apparatus,” ICES-003 of Industry Canada. Operation is subject to the following 
two conditions: (1) this device may not cause interference, and (2) this device must accept any 
interference, including interference that may cause undesired operation of the device. To reduce 
potential radio interference to other users, the antenna type and its gain should be so chosen that 
the equivalent isotropically radiated power (e.i.r.p.) is not more than that permitted for successful 
communication. 
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RF exposure warning: The equipment complies with RF exposure limits set forth for an 
uncontrolled environment. The antenna(s) used for this transmitter must not be co-located or 
operating in conjunction with any other antenna or transmitter.  

Le présent appareil est conforme aux CNR d’Industrie Canada applicables aux appareils radio 
exempts de licence. L’exploitation est autorisée aux deux conditions suivantes : (1) l’appareil ne 
doit pas produire de brouillage, et (2) l’appareil doit accepter tout interférence radioélectrique, 
même si cela résulte à un brouillage susceptible  d’en compromettre le fonctionnement.  

Cet appareil numérique respecte les limites de bruits radioélectriques applicables aux appareils 
numériques de Classe B prescrites dans la norme sur le matériel interférant-brouilleur: 
“Appareils Numériques,” NMB-003 édictée par industrie Canada. L’utilisation est soumise aux 
deux conditions suivantes: (1) cet appareil ne peut causer d’interférences, et (2) cet appareil doit 
accepter toutes interférences, y comprises celles susceptibles de provoquer un disfonctionnement 
du dispositif. Afin de réduire les interférences radio potentielles pour les autres utilisateurs, le 
type d’antenne et son gain doivent être choisie de telle façon que l’équivalent de puissance 
isotrope émis (e.i.r.p)  n’est pas plus grand que celui permis pour une communication établie. 
Avertissement d’exposition RF: L’équipement est conforme aux limites d’exposition aux RF 
établies pour un  environnement non supervisé. L’antenne (s) utilisée pour ce transmetteur ne 
doit pas être jumelés  ou fonctionner en conjonction avec toute autre antenne ou transmetteur. 

 
ABOUT THIS GUIDE 
LabNavigator 2, released in October 2012, ships with a Quick Start Guide intended to get you up 
and running with basic data collection and analysis. The LabNavigator 2 Reference Guide is an 
extended guide designed as a comprehensive resource detailing the features, hardware, and 
software of LabNavigator 2.  
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I. GETTING STARTED WITH LABNAVIGATOR  2 
 

What’s Included 
 LabNavigator 2 interface 
 Rechargeable battery 
 Power adapter 
 USB cable 
 Quick-Start Guide 
 Stylus (in unit) 
 Stylus tether 
 

Using LabNavigator 2 for the First Time 
 
Install the Battery 
LabNavigator 2 ships without the battery installed. To install the battery, follow these simple 
instructions. 

 Turn LabNavigator over and open the battery door by sliding the door lock and lifting the 
battery cover. 

 Remove the small protective sticker covering the battery contacts. 
 Install the battery with the label side up, ensuring the battery contacts align with the 

contacts on LabNavigator. 
 Replace the battery door and make sure the door lock clicks closed.  

 

 

LabNavigator with battery door removed 

 
Charge for 8 Hours 
We recommend charging the battery for eight hours prior to using LabNavigator for the first time 
on battery power. To do this, connect the included power adapter to LabNavigator and an AC 
power source. You can also charge LabNavigator using the LabNavigator 2 Charging Station 
(order code LN2-CRG, sold separately). 
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LabNavigator uses a high-quality lithium-ion battery. This is the same chemistry used in 
premium laptop and cell phone batteries, and you can expect similar performance. There is never 
a need to condition the battery by regular full discharge/charge cycles.  

It is safe to leave the battery charging indefinitely, and there is no need to fully discharge the 
battery before charging. Battery life will depend on the sensors used, but in most cases you can 
obtain six or more hours of use before recharging. We recommend charging LabNavigator 
overnight to start the next day with a full charge. For more details about the battery, see 
LabNavigator Battery. 

 

Quick Start to Data Collection 

Follow these steps to get up and running quickly with basic data collection. For more details, see 
Data Collection. 
 

1. Turn on LabNavigator by pressing and releasing the 
power button located on the top edge of 
LabNavigator. The LabNavigator App will launch 
automatically. 

 

 

 

 
2. Connect an analog sensor to the CH 1 port on 

LabNavigator (or connect a digital sensor to the 
DIG 1 port). LabNavigator App will auto-ID the 
connected sensor and automatically set up the 
default collection rate for the sensor. 

 Note: If your sensor is from a source other than 
Forston Labs but has a BNC connector, the sensor 
requires the use of the Electrode Amplifier and the 
sensor will not auto-ID. Instead, you will need to set 
up the sensor manually. To do this, tap the Sensors menu and choose Sensor Setup. Next, tap 
the field labeled “No Sensor” adjacent to the appropriate port to view a list of sensors. Tap 
to select the sensor. 

 
3. Next, tap Collect . Data collection will begin 

and LabNavigator will graph the data collection in 
real time. 
 
You can stop collection early by tapping Stop . 
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4. Once data collection is complete, the graph 
autoscales to the data. Tap the graph to examine a 
point of interest. The coordinates of the point are 
shown in the pane to the right of the graph. Tap 
another point or tap the Examine buttons to move 
the cursor left and right . 

 

5. To select a region of data for analysis, tap-and-drag 
across the graph to highlight the desired region.  

 Note: To analyze all of the data, you do not need to select a region.  

Statistics 

 To view statistics for the selected data, tap Analyze 
on the Graph screen, then choose Statistics. Tap the 
checkbox to select a data set. The statistics 
information is then displayed in the panel to the 
right of the graph. 

To remove the displayed statistics, tap Analyze on 
the Graph screen, choose Statistics, then tap the 
checkbox to unselect the data set. 

 
Curve Fit 

To fit a curve to the selected data, tap Analyze on 
the Graph screen, then choose Curve Fit. Tap the 
checkbox to select a data set. On the Curve Fit 
screen, tap Choose Fit, then choose the type of 
equation you would like to fit to the data. 
LabNavigator App will automatically determine the 
fit coefficients. A preview of the fit applied to the 
data  

 Note: The Curve Fit coefficients cannot be manually 
adjusted. To enter your own parameters, see the sub-section Model within Data Analysis. 

On the Curve Fit screen, tap OK to apply the fit and return to the Graph screen. 

To remove the fit, tap Analyze on the Graph screen, choose Curve Fit, then tap the checkbox 
to unselect the data set. 

For detailed information on these features, as well as other data collection and analysis options, 
see  

 LabNavigator App  



   

II. LABNAVIGATOR HARDWARE 

 

Once LabNavigator 2 is connected to AC power or the battery has been charged, press the power 
button located on the top of the unit, near the left edge. LabNavigator will complete its booting 
procedure and then launch the LabNavigator App by default, as shown above. If the screen does 
not light after a moment, connect the power adapter to LabNavigator and to an AC power source 
and try the button again. 

 

Power Button 
 Power on – If the screen is off for any reason (LabNavigator is off, asleep, or the screen 

has turned off to conserve battery power) pressing and releasing the power button once 
will turn LabNavigator back on. If LabNavigator was off, LabNavigator will also 
complete its booting procedure which takes about a minute and then display 
LabNavigator App.  

 
 Sleep/wake – When LabNavigator is on, pressing and releasing the power button once 

will put LabNavigator into a sleep mode. Note that the sleep mode does not start until 
you release the power button. In this mode, LabNavigator uses less power but the battery 
can still drain. This mode is useful if you are going to return to data collection again 
soon, in which case waking LabNavigator from sleep is quicker than a cold boot. To 
wake LabNavigator from sleep, simply press and release the power button. 

 
 Shut down – To shut down LabNavigator, hold the power button down for about five 

seconds. You will then see a message indicating that LabNavigator is shutting down. 
Release the power button, and allow LabNavigator to shutdown. To cancel the shutdown 
procedure at this point, simply tap Cancel. You can also shutdown LabNavigator by 
tapping Home , tapping the System folder, then tapping Shut Down . 

 
 Emergency Shutdown – If you hold the power button down for about eight seconds, the 

unit will power off uncleanly. This is the same as pulling the battery out of the unit while 
it is running. This is not recommended unless LabNavigator is frozen, as you may lose 
your data and potentially cause file system corruption. 
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Touch Screen 

LabNavigator has an LED backlit resistive touch screen that quickly responds to pressure exerted 
on the screen. LabNavigator is controlled primarily by touching the screen. The software is 
designed to be finger-friendly. In some situations, you may desire having more control for 
precise navigation. In such cases, we recommend using the included stylus. 

If you are having trouble viewing the color screen or are using LabNavigator outside in bright 
sunlight, we recommend changing to the High Contrast mode. From the Home menu, tap 
Preferences, then Light & Power. Tap the checkbox for High Contrast  to enable this mode. 

 

Hardware Keys 

In addition to using the touch screen, the three hardware keys 
can also be used to control your LabNavigator. 

 Collect – This key starts and stops data collection within 
LabNavigator App 

 Home – This key launches the Home screen 
 Escape – This key closes most applications, menus, and 

exits dialog boxes without taking action (i.e., cancels 
dialog boxes) 

 
 

Sensor Ports 

LabNavigator has three analog sensor ports (CH 1, CH 2, and CH 3) for analog sensors such as 
our pH Sensor, Temperature Sensor, and Force Sensor. Also included is a full-size USB port for 
USB sensors, USB thumb drives, and USB printers. In addition to the power button, the top edge 
of LabNavigator has two digital sensor ports (DIG 1 and DIG 2) for Drop Counters, and other 
digital sensors. 
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Also located on the top edge are the audio ports and a micro SD card slot for expanding disk 
storage. On the side opposite of the analog ports, there is a stylus storage slot, an AC power port 
for recharging the battery, and a mini USB port for connecting LabNavigator to a computer. In 
between these ports, there is a serial connection for charging the unit in a LabNavigator 2 
charging station (order code LQ2-CRG, sold separately), and a stylus tether attachment point.  

 
 

Internal Sensors 

LabNavigator also has several built-in sensors, including a GPS, microphone, accelerometers, 
temperature sensor, and relative light sensor. 

To enable internal sensors within LabNavigator App, tap Sensors, and choose Sensor Setup. 
Within the Sensor Setup dialog box, tap a checkbox to enable the associated sensor. Then tap OK 
to return to the LabNavigator App Meter screen.  

 

Sensor Setup dialog box 
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III. LABNAVIGATOR APP 

The data-collection and analysis software, LabNavigator App, is the heart of your LabNavigator. 
When you turn on LabNavigator, the LabNavigator App starts automatically. If the 
LabNavigator App is not showing on your screen, tap Home , and tap LabNavigator App . 

 

Navigating LabNavigator App 

The LabNavigator App has five different screens. Tap on the desired tab to display the associated 
screen. 
 

                

LabNavigator App 

 

 Meter screen – Set up sensors, data-collection 
parameters, and see a digital meter for your 
connected sensors. For a detailed description of 
how the Meter screen is used for data collection, 
see Data Collection.  

 

 

 
 Graph screen – See a graph of your data and 

perform statistical analysis of your data, 
including curve fits. For a detailed description of 
how the Graph screen is used for data analysis, 
see Data Analysis. 

 

 



 

    8

 Table screen – See a tabular representation of 
your data, create manual and calculated 
columns, and manually enter data. For a detailed 
description of how the Table screen is used for 
data analysis, see Manipulating Data from the 
Table Screen.  

 

 
 Methods screen – You can pre-load your own methods (converted to the proper file 

format using the included NavCoPilot Software) onto your LabNavigator for user 
reference. 

 
 

 Notes screen – Record observations about your 
experiment. For more information, see Adding 
Notes. 

 
 
 
 

File Menu 

A LabNavigator App file can contain data collection settings, graphs, data tables, analyses, and 
even notes. These files have a .qmbl extension and can be saved to the internal storage space on 
LabNavigator or to an external storage space such as a USB thumb drive or micro SD card.  

All five tabs within LabNavigator App share the same 
File menu which is similar to the File menu on a 
computer. From the File menu, you can perform a 
number of tasks related to LabNavigator App files, such 
as opening, saving, and closing files, adjusting file 
settings, printing, and more. These are described in 
more detail as follows. 

 New – Choosing New from the File menu will 
close the existing file and open a new file. If you 
have unsaved data, you will be prompted to either save or discard the data before 
continuing. This is an easy way to reset the data collection mode and calibrations back to 
default values. 

 Open – Choosing Open from the File menu 
displays a list of files that you have saved on 
LabNavigator. To open a file, tap on the file 
name, then tap Open. To open a file from an 
external storage source, tap the source icon 
( USB,  SD) to display the files available on 
that source, then tap on the file name, and tap 
Open. 
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 Save – Choosing Save from the File menu displays the Save As dialog box where you 
can tap on a source icon ( USB,  SD,  LabNavigator) to select a destination, then 
tap in the File name field to assign a name to the file. 

 
 Delete – Choosing Delete from the File menu displays a file list similar to that accessible 

by choosing open. Tap on a source icon ( USB,  SD,  LabNavigator) to select the 
source of the file to be deleted, then tap the file name to be deleted, then tap Delete. You 
can delete only one file at a time. 

 
 Email – Choosing Email from the File menu allows you to email the Data File, Graph, 

Text File, or Screen Shot from the current file, if you are connected to a wireless network 
with Internet. For detailed instructions on setting up this feature, see Emailing from 
LabNavigator. 

 
 Export– Choosing Export from the File menu allows you to export the currently opened 

data file in a text format for use with other applications. Tap on a source icon ( USB, 
 SD,  LabNavigator) to select a destination, then tap OK to complete the export. 

 
A typical use of this feature is to export a text file to an SD card or a USB flash drive for 
further data manipulation on a computer with a spreadsheet program. The exported file 
contains all column values from all runs in the current session, delimited by tabs. For 
more detailed instructions on using this feature, see Storing LabNavigator App Files.  

 
 Print – Choosing Print from the File menu allows you to print the Graph, Table, Methods, 

Notes, or Screen from the current file to a USB or Wi-Fi-enabled printer.  For detailed 
instructions, see USB Printing and Wirelessly Printing from the LabNavigator, 
respectively. 

 
 Settings – Choosing Settings from the File menu allows you to adjust file settings for the 

current session. These settings are not global; rather, they are specific to and saved within 
the LabNavigator file. These settings return to the default upon choosing New from the 
File menu. 
o Angle Units for Trigonometric Calculcations - Calculated columns, curve fits, and 

modeled functions may use trigonometric calculations; choose Degrees or Radians 
here. The default is set to radians. 

o Number of Points for Derivative Calculations – Calculated columns, curve fits, 
modeled functions, and even the automatic setup for sensors may use numerical 
derivatives. The algorithm for such derivatives utilizes a user-defined number of 
points. The default value of seven points is good for many tests but you may want to 
choose a larger number. 

 
 Quit – Choosing Quit from the File menu exits the LabNavigator App. Since other 

applications can be run simultaneously with LabNavigator App, there is typically no need 
to quit the LabNavigator App during standard use.  

 

Data Collection  

The Meter screen, selectable by tapping the Meter tab , is the default view for the 
LabNavigator App. Use the Meter screen to set up your sensors and data-collection parameters, 
as well as to monitor a real-time reading of your sensor. 
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Digital Meters 
A digital meter for each connected sensor is shown on 
this screen. Tap on a meter to change the sensor’s 
settings. The available options will depend on the sensor 
and may include options such as change units, calibrate, 
zero, and reverse. These options can also be accessed by 
tapping Sensors, and choosing the desired option from 
the menu. 

 
 
 

Data-Collection Summary 
A summary of the data-collection settings (Mode, Rate, Duration) is 
shown in the pane at the right of the Meter screen.  

For most sensors, the default data-collection mode is Time Based. The 
default collection rate for the connected sensors is set up automatically 
when LabNavigator identifies the sensor. To modify the data-collection 
settings, tap on the summary box. Alternatively, you can tap Sensors, 
then choose Data Collection. For detailed descriptions of data-collection 
modes and parameters, see Data-Collection Settings.  

Data-Collection Controls 
Tap the Collect button  displayed in the lower right corner of any LabNavigator App screen 
to start data collection. During data collection, this button changes to a Stop button  which 
you can tap at any time to end data collection. 

During selected data-collection modes (e.g., Events with Entry), a Keep button  will appear 
to the right of the Stop button. In this mode, you must tap  to record the data point in the 
data table. For more information, see Events with Entry.  

Data-Collection Settings  
The Sensors menu gives access to detailed setup 
controls. Use this menu to set up the internal sensors, 
non-auto-ID sensors.  You can also use this menu to 
change the data collection parameters and specific 
sensor settings.  

 

 Sensor Setup – Choosing Sensor Setup from the 
Sensors menu displays a dialog box showing 
which sensors are currently connected. If you 
are using a sensor that does not auto-ID, you 
will need to manually set up the sensor. To do 
this, tap on the field displaying “No Sensor” for 
the channel to which your sensor is connected. 
In response, LabNavigator displays a list of 
possible sensors. Tap to select the appropriate 
sensor. Then tap OK. 
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You can also activate (or deactivate) the internal sensors from the Sensor Setup. Check 
the box next to the desired sensor to make that sensor available for data collection.  

 
 Data Collection – Choosing Data Collection 

from the Sensors menu displays allows you to 
set the data-collection mode and associated 
parameters. The parameters listed will depend 
on the mode selected.  
 

 
 
 
 

o Mode: Time-Based – Time-based data 
collection is the default data-collection 
mode for most sensors. In this mode, 
sensor readings are recorded at regular 
time intervals. 

 
Adjustable parameters for this mode 
include the rate (or interval) and the 
duration of data collection. The total 
number of samples to be collected based 
on these parameters will be displayed. 

Under some circumstances, the Rate and 
Duration fields may be highlighted in 
yellow or red. The yellow warning 
indicates that the rate has been set to 
value slower or faster than what is 
recommended for the connected sensor, 
or that the number of samples could lead 
to performance issues. The red warning 
indicates one of the following: the rate has been set to a value slower or faster 
than what a connected device and/or sensor configuration can support; the number 
of samples exceeds the storage available; or, the number of samples exceeds  
2000 (for rates faster than 80,000 samples per second). 

 
Triggering – Triggering is only available 
in the Time Based mode, and can be 
enabled by simply tapping the associated 
checkbox. When enabled, LabNavigator 
will wait for a trigger condition to be met 
before beginning data collection. The 
sensor name, the level, and the direction 
of change (increasing or decreasing) can 
all be set here. You can also set the 
number of points to be saved before the 
trigger condition is met.  

 
Advanced – The Advanced field has 
three options that can be independently 
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enabled by simply tapping the associated checkbox.  
Oversampling can be used with data-collection rates less than ten samples per 
second. When Oversampling is enabled, the sensor will sample at a rate 
higher than the number of samples per second that you set, and then 
LabNavigator averages those readings and records the averages in the data 
table. This setting can be used to reduce measurement noise by combining a 
burst of readings into one value. For example, oversampling can sometimes 
reduce the influence of unseen but real variations, such as as those from a 
flickering light source. 
 
Repeat can be used with data-collection rates less than 250 samples per 
second. When Repeat is enabled, a new data-collection run is started as soon 
as the current run has ended. Data for each run is overwritten when a new run 
is started. This setting is helpful when doing exploratory investigations. 
 
Enable Data Marking can be used to 
mark points of interest during a 
time-based data collection. When 
enabled, a Mark Data button  
will appear when data is being 
collected. Simply tap  duing 
data collection to mark that 
particular point as a point of interest. 
After completing data collection, 
data marks can be named as part of 
the analysis process. 

 
 

o Mode: Events with Entry – Sometimes 
experiments do not depend on time, but 
depend on the setting of another 
quantity. For example, using Boyle’s law 
one wants to know the pressure as a 
function of the volume of gas. Thus, in 
Events with Entry mode, no time 
information is recorded. 
 
When setting up this mode, you can 
enter a name and units for the entry, or independent variable, column. One or two 
additional columns of data can be entered as you collect data. You also have an 
option to average data over ten seconds and report the averaged reading.  
 
In Events with Entry mode, once data 
collection is started, a Keep button  
appears. Tap the Keep button to record 
the sensor value (e.g., gas pressure in the 
Boyle’s law application). In response, 
LabNavigator will prompt for the Entry 
value (e.g., gas volume in the Boyle’s 
law application). Sensor values are 
plotted versus the Entry values, as shown 
in the screenshot at right. 
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o Mode: Selected Events – Selected Events is similar to the Events with Entry 
mode, except that entries of 1, 2, 3… are entered automatically for you. No time 
information is recorded in Selected Events mode.  

 
 
 
 
 

o Mode: Full Spectrum – Full Spectrum 
data-collection mode can only be used 
with Spectrometers and is the default 
mode when a Spectrometer is connected. 
In Full Spectrum mode, Intensity, 
Absorbance, Fluorescence (NavSpec+ 
only), or %Transmittance can be 
measured as a function of wavelength. 
 
 

 
o Mode: Gas Chromatograph – LabNavigator 2 supports the use of the Forston Labs 

Mini Gas Chromatograph (GC). When a Mini GC is plugged in the 
LabNavigator 2 USB port, the software will automatically identify the Mini GC 
and select the Gas Chromatograph mode. This mode should not be entered unless 
a Mini GC is attached.  
 

In this mode, various parameters are 
defined for the user to establish a 
temperature and pressure profile 
adequate for the current experiment. 
When the mode is first entered, a set of 
default parameters is displayed. If you 
wish to change these parameters, tap in 
the parameter field to enter a new value 
or adjust the default value by tapping the 
arrow buttons. These values will be 
reflected in the preview of the time-dependent temperature graph displayed at 
right. After setting the parameters, tap OK to initiate the Mini GC warm up. 
 
Note: A new message will appear, “Do not inject until GC is ready.” The 
Mini GC will take a few minutes to warm up and stabilize. When the Mini GC is 
ready for injection, the message will read, “Inject and select Collect 
simultaneously.”  

 
 

o Mode: Drop Counting – In this mode, you can choose to calibrate drops so that the 
volume of titrant is recorded in units of milliliters. Choose Calibrate from the 
Sensors menu. The Forston Labs Drop Counter is set to use a default calibration 
of 28 drops/mL. If you choose to calibrate the sensor, the volume of an individual 
drop will be determined by the number of drops that pass through the Forston 
Labs Drop Counter and dividing by the total volume of the drops. Follow the 
instructions on the screen to complete a custom calibration. Alternately, the 
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Equation tab allows you to input a previously determined value for drops/mL.  
Enter the drops/mL value (e.g., 28.0), then choose OK. 

 
o Mode: Data Matrix – This mode is 

primarily used for field work. It provides 
a way to collect data referenced to two 
parameters such as the locations of the 
sampling sites and the dates on which 
they were sampled. It also allows you to 
collect data from an unlimited number of 
sensors by permitting sensors to be 
swapped in and out of LabNavigator 
during data collection. 

 
 

 Change Units – In some cases, you may have the option to display the sensor data in 
another set of units. Choosing Change Units from the Sensors menu allows you to select 
a different set of units. Choosing a new unit will change all existing runs for that sensor 
to the new unit, as well as any subsequent runs. If this feature is grayed-out in the menu, 
then the data for that particular sensor cannot be displayed in another set of units. 

 
 Calibrate – Most sensors do not need to be calibrated, as a factory calibration for that 

sensor is read from the sensor when LabNavigator identifies it. However, some sensors 
do require calibration and you will use the Calibrate tool accessible from the Sensors 
menu. In such cases, follow the detailed calibration instructions provided in the USB 
drive included with your LabNavigator. Sensor booklets are also available online at 
www.forstonlabs.com 

 
 Zero – Choosing Zero from the Sensors menu will set the current sensor reading to zero 

by adding an offset to the current reading. Not all sensors can be zeroed. 
 

 Reverse –Some sensors read both positive and negative values. Choosing Reverse from 
the Sensors menu will swap the sign of the readings with respect to the default settings. 
Not all sensors can be reversed. 

 
 
Graph Settings 
LabNavigator App automatically switches to the Graph 
screen when data collection begins. From this screen, 
you can adjust graph settings in real-time during data 
collection, or after data collection has ended. You can 
choose what is plotted, how the graph is scaled, how the 
data is formatted, and choose data to ignore by striking 
through the values. 
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 Graph Options – To control how the data are 
graphed, tap the Graph menu and choose Graph 
Options. Here you can choose the columns used 
for the x- and y-axes and the axes limits. 
 
Selecting Autoscale will cause the graph range 
to adjust to the data range after data collection 
ends. Autoscale from 0 does the same, but 
includes the origin. Manual scaling will respect 
values entered in the range limits, unless 
incoming data falls outside the range. In this 
case the range will expand to include the data. 
To enter range limits, tap in each field and use 
the keyboard to enter numeric values. 
 
The Point Symbols option is selected by 
default, and will surround some, but not all, of 
the points with a circle. This allows easy 
identification of a trace by the corresponding 
mark in the graph legend. Simply tap the associated checkbox to disable this feature.  
 
The Connect Points option connects data points with straight-line segments. These lines 
help the eye follow the data trend, but in some cases are not appropriate. On by default, 
unchecking Connect Points will leave only the actual points on the graph.  
 
To specify which columns are being graphed, tap the desired column under the proper 
run heading to place a checkmark. 
LabNavigator can display a single graph, or two graphs. The two graphs share a common 
x-axis column and range. Tap the triangle next to Graph 1 Y-Axis or Graph 2 Y-Axis to 
show or hide the settings for that axis. If no column is selected for Graph 2, only one 
graph will be drawn.  
 
When you are done setting Graph Options, tap OK to return to the Graph screen. 
 

 Show Graph – Choosing Show Graph from the Graph menu lets you quickly jump 
between displaying one or two graphs. You can also choose the Full Width option, to 
remove the data collection summary box and maximize the graphs on the screen. 
 

 Store Run – You can collect several runs for 
comparison. Choosing Store Run from the 
Graph menu allows you to save the current run, 
and then proceed with more data collection. As a 
shortcut, you can simply tap the File Cabinet .  
 
Collect another run by tapping the Collect 
button. Your new run is displayed on the graph. 
To see your first run, tap the Run 2 button to the 
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left of the Filing Cabinet, and select either Run 1 or All Runs. In this way, you can gather 
multiple runs for comparison, and view just the ones you want. 

 

Data Analysis  

In addition to data collection, LabNavigator App also allows you to analyze the data within 
LabNavigator.  

Data can be analyzed from the Graph screen, selectable by tapping the Graph tab , as well as 
the Table screen, selectable by tapping the Table tab . Several common analysis features are 
described in greater detail, below. 

 
Examining Data on the Graph Screen 
To examine data from the Graph screen, tap on a data point of interest. The Examine cursor 
jumps to the data point with the nearest x-value to that which you tapped. Cursor lines highlight 
the x- and y-axis values, and the right-side readouts display the associated numerical values of 
the point. You can make fine adjustments to the cursor location by using the Left Examine 
Button  and Right Examine Button  located on either side of the horizontal-axis label. 

In some cases, you may want to examine data for a particular region on the graph. To select a 
portion for analysis, simply tap and drag across the desired region. You can adjust the trailing 
endpoint of the selected region using the Examine Buttons, if needed. Or, for greater control, you 
can optionally use the stylus. 

 

Adjusting the Graph View 
You can adjust the graph view in real time during data collection, or after data collection has 
ended, by applying one of the following actions from the Graph menu. 

 Autoscale Once – Tap Autoscale Once will 
quickly reset the axes of the currently selected 
graph based on the data. It is an easy way to 
automatically scale both axes. 

 Zoom In – Select a region on the graph, then tap 
Zoom In to automatically adjust the axes for 
viewing the selected region. 

 Zoom Out –Tap Zoom Out to undo a Zoom In 
and return the graph axes to the previous 
settings.  If Zoom In is used several times, Zoom Out will undo each Zoom In, one at a 
time. 

 Graph Options – Tap Graph Options to manually adjust graph settings. To adjust the 
graph view, change the values in the Left and Right fields for the x-axis and y-axis. 

 
Manipulating Data from the Graph Screen 
You can manipulate data from the Graph screen or from the Table screen. If using the Graph 
screen, first tap to select a data point of interest or tap-and-drag to select a region of data. Then, 
choose the desired tool from the Graph menu. Upon tapping on the tool, the action will be 
applied to the data. 
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 Strike Through Data and Restore Data – Use these tools to ignore/restore selected data. 
Struck data are ignored for analysis and graphing, and the graph will update accordingly. 
To restore all data, tap the Graph menu and choose Restore Data. 

 Tag Data – Use this tool to tag a data point with a comment. After selecting the point and 
tapping Tag Data, a circle will be displayed on the graph to “tag” the data. To add a 
comment, tap in the info box at the right and enter a comment into the blank field. 

 
Analyzing Data from the Graph Screen 
The Analyze menu on the Graph Screen gives you 
access to additional tools such as tangent lines, 
integrals, statistics, and curve fits. To apply one of these 
tools, tap the Analyze menu and tap to select the desired 
tool. If prompted, select a column or data set to which 
the analysis will be applied. 

Upon enabling an analysis tool, a summary of analysis 
information is displayed at the right. Scroll arrows will 
appear, if needed. Optionally tap the summary to 
display the values on a detail dialog for ease of reading. 

The following analysis tools are available from the 
Analyze menu. 

 Tangent – The Tangent mode enhances the 
Examine cursor by adding a tangent line and 
numeric display of the slope as you tap different 
locations on the graph.  

 
 Integral – The Integral tool numerically 

integrates graphed data. Select a region, if 
needed, then choose Integral from the Analyze 
menu. Enable the tool by tapping on the 
displayed sensor or column name. The integral 
will be drawn, and the numeric result will be 
displayed to the right of the graph. 

 
 
 

 Statistics – The Statistics tool displays statistics 
for graphed data. Select a region, if needed, and 
then choose Statistics from the Analyze menu. 
Enable the tool by tapping on the displayed 
sensor or column name. Descriptive statistics 
will be displayed to the right of the graph. If a 
region is selected, brackets are drawn to indicate 
the region used for calculations 

 
 

 Delta – The Delta tool opens a preview window 
where you can examine x- and y-deltas. Choose 
Delta from the Analyze menu to open the 
preview window. Then tap-and-drag to create a 



 

    18

box overlaid on the graph. The vertical side of the box yields y, and the horizontal side 
of the box yields x. Tap OK to keep these values and display the box on the Graph 
screen. To exit the Delta tool without displaying the box on  the Graph screen, tap 
Cancel. 

 
 Curve Fit – The Curve Fit tool allows you to 

automatically fit a chosen function to your data. 
If a region of the graph is selected, only that 
region is used for fitting. If there is no selection, 
the entire graph is used.  

 
Enabling the curve fit displays a Curve Fit 
dialog box. Choose the desired fit equation from 
the drop-down menu. Upon choosing the fit 
equation, LabNavigator will display the fit in the 
preview graph at left. The fit coefficients and Root Mean Square Error (RMSE) are also 
displayed. Tap OK to keep this fit and display the curve on the Graph screen. To exit the 
Curve Fit tool without applying the curve, tap Cancel. 

 
Tip: The RMSE (root mean square error) is a measure of how well the fit matches the 
data. The smaller the RMSE, the closer the data are to the fitted line. The RMSE has the 
same units as the y-axis data.  

 
 
 

 Interpolate – Once you have performed a curve 
fit, you can use the Interpolate function to read 
values off of the fitted function. Choose 
Interpolate from the Analyze menu to enable the 
tool, then tap on the graph. The lines associated 
with the Examine cursor now locate a position 
on the fitted function, and coordinates along the 
fitted line are shown in the summary box at the 
right of the graph. You can tell that 
LabNavigator is in the Interpolation mode by the 
square cursor shown at the Examine point. 

 
 Model –Model allows you to manually fit a 

chosen function to your data. Enabling the 
Model tool displays a Model dialog box where 
you can choose the desired model equation from 
the drop-down menu.  
 
The model parameters (e.g., A, B and C) are 
adjustable. Change them by direct entry or by 
using the up and down arrows. Upon choosing 
the equation, LabNavigator will display the 
modeled function in the preview graph at left. Tap OK to keep this function and display 
the modeled function on the Graph screen. To exit the Model tool without applying the 
function, tap Cancel. 
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Tip: If no function appears when modeling, your parameters are defining a curve that is 
outside of the plot window. 
 

 Advanced – Choosing Advanced from the 
Analyze menu allows you to access advanced 
analysis tools including Baseline Adjustment, 
Fast Fourier Transform (FFT), and Peak 
Integration. 

 
o Baseline Adjustment – This tool applies 

a factor that raises or lowers the x-axis. 
Because the LabNavigator App uses the 
x-axis as its baseline when calculating an 
integral, adjusting the baseline may result 
in a better integral. 
 

o FFT – The FFT tool calculates a Fast 
Fourier Transform of the selected data.  
The FFT is displayed in a special graph 
that can be analyzed. Tap OK to return to 
the main graph. The peak frequency will 
be displayed on the graph legend.. 

 
o Peak Integration – This option calculates the integral for a selected portion of a 

graph. It is most commonly used with the Forston Labs Mini GC, but it can be 
applied to any data plot. Peak Integration differs from the Integral tool in that it 
does not use the x-axis as the baseline. Instead, the integral for Peak Integration is 
evaluated from the minimum y-values to the left and right of a selected peak. 

 
 Draw Prediction – The Draw Prediction tool 

gives you a free-hand sketch tool for drawing on 
the Graph screen. This can be used for a variety 
of purposes, but is most often used to sketch a 
prediction of how a graph will appear once data 
are subsequently collected.  
 
Upon enabling this tool, tap-and-drag across the 
screen for smooth curves, or tap the screen to 
connect subsequent taps with straight-line segments. The Reset button will remove your 
sketch if you need to start over. Tap OK to place your sketch on the main graph. To 
remove a prediction, choose Draw Prediction again from the Analyze menu. 
 

Adjusting the Table View 
In addition to viewing and manipulating data from the 
Graph screen, you can also work with the data from the 
Table screen. Tap the Table tab to change to the Table 
screen. There are several shortcuts on this screen. 
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Alternatively, you can also access the fields by choose Data Column Options from the Table 
menu. 

 Tap Run 1 in the name field to rename the run. 
 Tap a column header (Time, Position, etc.) to change the column name, units, or 

displayed precision.  
 
Manipulating Data from the Table 

Screen 
The Table menu allows you to create, modify, or delete 
columns of data. Anything in columns can be graphed. 
The following tools are available from the Analyze 
menu: 

 New Manual Column –New Manual Column 
creates an empty column into which you can 
enter or generate values directly. Tip: To make a graph of data from other sources, enter 
values in two manual columns, and then plot them in a LabNavigator graph. 

 
 New Calculated Column –New Calculated 

Column creates a new column whose values are 
based on other columns by a mathematical 
formula. Tap the Name field to enter a name for 
the new column, tap the units field to enter the 
units, then tap the Equation Type field and 
choose an equation for the calculations in this 
column. For example, you might define a 
calculated column as the inverse square of 
another column. After creating a calculated 
column, you can display the calculated data on a graph, or manipulate it further with 
additional calculated columns. 

 
 Data Column Options – This allows you to access the fields for setting the column name, 

units, and displayed precision. Alternatively, you can access these fields by simply 
tapping on the column name from the Table screen. 

 
 Delete Data Column – This allows you to delete a manual or calculated column of data. 

Note that you cannot delete data collected from a sensor; however, you can hide data 
using the Strike Through Data tool. 

 
 Delete Run – If you have stored at least one run using the Store Run tool, this option will 

be selectable from the Table menu. Upon choosing Delete Run, tap the desired run name 
to delete the run. You will not be able to delete the last run created. 

 
 Clear All Data – This action will clear all data in the table. Upon choosing this option, you 

will be prompted to confirm. 
 

 Strike Through Data and Restore Data – Use these tools to ignore/restore selected data. 
Struck data are ignored for analysis and graphing, and the graph will update accordingly. 
To restore all data, tap the Table menu and choose Restore Data. Note that you can also 
access these tools from the graph screen by tapping on the Graph menu. 
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 Tag Data – Use this tool to tag a data point with a comment. After selecting the point 
within the table and tapping Tag Data, a circle will be displayed on the graph screen to 
“tag” the data. To add a comment, tap to select the Graph tab, locate the tagged point and 
tap to place the Examine cursor at this point. Then tap the info box at the right and enter a 
comment into the blank field. 

 
 Edit  – This tool allows you to copy and paste values from one place to another. In 

particular, you might copy a range of values and paste them into notes on the Notes 
screen.  

Viewing Methods 

The Methods screen, selectable by tapping the Lab Instructions tab , allows the user to view 
pre-loaded method instructions developed using the included NavCoPilot Method software. 

Opening Forston Labs Methods 
From the View screen, choose View Methods from the View menu. Tap on the desired method, 
tap OK, then choose the desired lab and tap OK. 

In addition to scrolling through the instructions using the scrollbar at right, you can also zoom in 
on a particular portion of the instructions by selecting Zoom In from the View menu. Selecting 
Zoom Out from the View menu restores the previous view. Selecting Reset from the View menu 
restores the original view. 

 
Adding Methods 
 
Creating Your Own Methods 
If you would like to create your own method content, you can do so using the NavCoPilot 
Software included with your LabNavigator.  

Install the software on your PC, double click to open and the “Help” tab gives you step by step 
instructions on developing and loading your methods.  

When your content is complete download your method to a USB flash drive or SD card. 

Follow the provided instructions to transfer the update from the flash drive or SD card to your 
LabNavigator. 

 

Adding Notes for your Test 

The Notes screen, selectable by tapping the Notes tab , allows users to enter notes as they 
perform an test. The menu gives access to standard edit commands of Cut, Copy, Paste, and 
Clear All.  
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Storing LabNavigator App Files 

LabNavigator files have a .qmbl extension and can be saved to the internal storage space on 
LabNavigator, or to an external storage space such as a thumb drive.  

LabNavigator will recognize additional storage space in a connected micro SD (Secure Digital) 
card or a USB flash drive. The drive or card may be formatted in FAT16 or FAT32 (the most 
common Windows and Mac OS formats) for reading and writing. 
LabNavigator cannot read NTFS- or HFS+-formatted drives. 

To save a LabNavigator App file,  

1. If saving to a micro SD card or USB flash drive, make sure the 
drive is inserted in the appropriate port on LabNavigator. Note: 
After inserting the drive wait a few seconds while LabNavigator 
recognizes the drive before proceeding. 

2. Choose Save from the File menu. This opens a Save As dialog box. 

3. Tap on the appropriate icon to select your storage destination. 

 - LabNavigator internal hard drive 

 - Micro SD card 

 - USB flash drive (thumb drive) 

4. After selecting your destination, tap on the name field to pull up the keyboard. Then enter the 
file name. 

5. Tap OK to return to the Save As screen. 

6. Tap Save to save the file. 

Note: You cannot create directories within LabNavigator App, but you can use directories that 
already exist on the SD card or USB drive. We recommend organizing your files on a USB drive 
or SD card by creating any needed folders on a computer before you use the drive or card with 
LabNavigator. 
 

Exporting LabNavigator App files 

In some cases, you may wish to export the LabNavigator App file in a text format (.txt) for 
further analysis within a program such as Excel. 

To do this, select Export from the File menu. Follow steps similar to those described in Storing 
LabNavigator App Files and choose Export from the File menu instead of Save As.  

To open the file in a spreadsheet program, be sure the program’s file browser is set to look for all 
files. Select your text file, then open it as you would any other .txt file. 

If you have access to a wireless network with Internet, you can email the data file, graph, text 
file, or screenshot. For detailed instructions, see Emailing from LabNavigator. 
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Printing from LabNavigator App 

You may choose to print the graph, data table, methods, your own notes, or the screen as it is 
currently displayed in LabNavigator App. LabNavigator can print to a compatible printer via a 
USB cable or via a Wi-Fi network. To check current compatible printers please contact us at 
www.forstonlabs.com or at 800-301-1259 

 
USB Printing 
For printing to a USB printer for the first time, simply connect a compatible printer to the full-
size USB port on LabNavigator, and turn on the printer.  

1. Tap the Home icon at the bottom of the screen, tap 
Preferences, and then tap Printers. 

2. Tap the Add Printer button on the Printer 
Configuration screen. 

 

 

     

3. Select the printer that appears in the list and tap 
Install. 

 

 

 
 

4. Tap Install again to complete the printer installation 
process. 

   

 

 

 
5. Close the Printer Configuration by tapping the X at the top right of the screen. This 

procedure need only be performed the first time you connect a particular printer. 

 
To print, choose Print from the File menu. Tap to choose the item that you want to print. The 
Print Options screen appears and you may choose the printer and enter a Title and/or Footer for 
your printout. Tap Print to send the item to the selected printer. 
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Even though your printer may initially appear in the Printer list, a driver may not be found when 
you tap the Install button. Not all printers are supported. If a driver is found, printing may still 
error due to an incompatible printer. If you are sure that the printer is compatible and you are still 
getting an error, it may be caused by one of the following conditions: out of paper, out of 
ink/toner, a door on the printer is ajar, a paper jam, or you may have selected the wrong printer 
on the Print Options screen. 

If you have access to a Wi-Fi enabled printer, you can print wirelessly. For detailed instructions, 
see Wirelessly Printing from LabNavigator.  

IV. USING LABNAVIGATOR 2 WITH A MOBILE DEVICE 

LabNavigator 2 includes Forston Labs Data Share, a feature that broadcasts sensor data to one or 
more devices wirelessly from the LabNavigator 2 interface. Using a compatible web browser, 
users can: 

 collaboratively collect experiment data 
 analyze an individual copy of the data on their device 
 examine their data and perform analyses such as statistics, linear fits, and quadratic fits 
 add a title and comment to their graph 
 use photo or screenshot features on their device to capture an image of the graph for their 

lab report 
 
To use LabNavigator 2 with a mobile device, follow these instructions. 
 
Set up data sharing on LabNavigator 
1. From the Home screen, tap Connections. 

2. From the Connections screen, tap Connection Information.  

3. From the Connection Information dialog box, tap the Name field to enter a name for the 
LabNavigator (e.g., LabNavigator A). Then tap  to close this window. 

 Note the HostName that is displayed. The HostName will be a combination of the name 
(without spaces) followed by .local (e.g., LabNavigatorA.local). 

 4. From the Home menu, tap Connections, then tap Data Share/Graphical Analysis.  

 
5.  From the Data Share/Graphical Analysis dialog, turn on data sharing by tapping On. 

Optionally, you can also choose to allow remote control of data collection on the 
LabNavigator from the mobile device. Tap  to close this window. 
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Connect LabNavigator to a Network 
6. Tap Connections on the Home screen, then tap Network.  

7. Tap to enable the Wi-Fi radio. 

 A Network Configuration dialog box is displayed listing any networks that LabNavigator 
sees, as well as an option to Create Network. 

Existing network 

 If you have an existing network to which you would like to connect, locate the network 
within the list and tap to select.  

Create a new LabNavigator Network (Ad-Hoc Network) 

 If you do not have access to an existing Wi-Fi network you can quickly and easily set up a 
network with LabNavigator 2. 
Note: This will allow users to connect to this network with their mobile devices. This network 
will not support access to the internet. The email function of LabNavigator will not work with 
a LabNavigator ad-hoc network.  

 From the Network Configuration box, tap Create Network. 
 Tap the Network Name field and assign a name to this new network (e.g., My Network). 

 
 Optional: Protect your network by assigning a 

password to your network that you will provide 
only to your students. To do this, select the 
Passphrase check box and assign a password to 
your new network (e.g., science).  

 Tap Create. 
 

 Note: Some Android implementations seem to have 
trouble viewing and connecting to ad-hoc networks. 
These devices require the use of an existing (infrastructure) network. 

 
Access LabNavigator from your Mobile Device 
8.  On your mobile device, connect to the same network to which LabNavigator is connected  

(step 7). 

9. On your mobile device, open the browser and type in the HostName for your device (e.g., 
LabNavigatorA.local). 

 Optional: If your mobile device has a QR-code reader, tap Connections from the Home 
screen on LabNavigator and then tap Data Share/Graphical Analysis. A QR-code associated 
with the HostName is displayed. Use a QR-scanning application on your mobile device to 
connect to your LabNavigator. 

 



   

V. USING LABNAVIGATOR WITH A COMPUTER 

Transferring Data from LabNavigator to a Computer 

Automatically transferring data: 

Forston Labs provides custom PC Apps at reasonable rates for sending data directly to your 
hard-drive for use in your existing or new LIMS or Control Systems at selected intervals.  Please 
contact us at info@forstonlabs.com or 800-301-1259 for details. 

Manually transferring data: 

You can also download any saved data from LabNavigator to the computer. After an experiment 
is complete on LabNavigator, choose Save from the LabNavigator File menu. Give the 
experiment an identifying name. You may save multiple LabNavigator files on LabNavigator 
this way.  

Tip: When taking data in the field, store experiments as files on the LabNavigator. To do this, 
choose Save from the File menu, and give the experiment a descriptive name. Choose either the 
LabNavigator, or optionally a USB drive or SD card, as the location. This way you can save as 
many tests as you like.  

 
Deleting Data on LabNavigator 
The LabNavigator Browser includes a Delete function. Choose Delete from the LabNavigator 
Browser, and select the file you want to remove from LabNavigator. 

Tip: Use the LabNavigator Browser to mass delete files from LabNavigator. Click to select 
multiple files, and click Delete. This is the only way to delete more than one file at a time. 

 

 



   

VI. EMAILING FROM LABNAVIGATOR 

If LabNavigator is connected to a network with Internet access, you can email your data file, 
graph, text file, or screen shot. 

 
To set this up, follow these instructions: 

1. First, you will need to connect LabNavigator to a network with Internet. To do this, follow 
steps 6-8 from Connect LabNavigator to a Network. 

 Note: A LabNavigator Network (Ad-hoc Network) does not have Internet access. You will 
need to join an existing network with Internet. 

2. From the Home screen, tap Connections, then tap Email.  

3. The Email Configuration dialog box is displayed. Enable email by selecting On. 

4. Enter your outgoing email server information and tap Save.  



   

VII. WIRELESSLY PRINTING FROM LABNAVIGATOR 

As described in USB Printing you may print wirelessly by connecting directly to a compatible 
Wi-Fi enabled printer or by connecting to a Wi-Fi access point that is wired to a network which 
includes a compatible printer.  

You can set this up as follows: 

1. First, you will need to connect LabNavigator to a network with Internet. To do this, follow 
steps 6-8 from Connect LabNavigator to a Network.  

2. Once you have connected, either to the Wi-Fi printer itself, or to a Wi-Fi access point, you 
are ready to follow the same instructions as described in USB Printing. 



   

VIII. ADDITIONAL APPS ON LABNAVIGATOR 

Several accessory applications can be launched from the Home menu. It is not necessary to quit 
the LabNavigator App to use these accessories; to return to LabNavigator App, either close the 
accessory using the close button in the upper right corner of the screen, or switch to the 
LabNavigator App by tapping LabNavigator App from the Home menu. 
 

Audio Function Generator  

From the Home screen, tap Audio Function Generator 
to launch this app. The function generator is used to 
create waveforms in the audio frequency range. Select a 
waveform, frequency, and volume for each channel. 
Start and stop using the buttons at left. The link between 
left and right channels is on by default, so that both start 
and stop together. Click the link icon to control the 
channels independently.  

The sliders can also be used to control frequency. Tapping left or right of the slider will halve or 
double the frequency.  

 

Periodic Table 

From the Home screen, tap Periodic Table to launch 
this app. The Periodic Table contains standard reference 
information on the elements. Tap an element to see 
details; close the detail window using the upper right 
close button. 

 

Calculator 

From the Home screen, tap Accessories, then tap 
Calculator. 

This app is a standard scientific calculator which uses 
algebraic notation. You can use this calculator at any 
time; to dismiss it, tap Home. You can copy a calculator 
result and paste it into the Notes tab. 

Sound Recorder  

From the Home screen, tap Accessories, then tap Sound 
Recorder. 

The sound recorder is used to capture short audio clips, 
typically for voice notes. To record a clip, tap the record 
button . To stop, tap the square red stop button. Play 
the clip back using the green play button. The disk 
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button allows you to save the clip, which can later be opened using the open file folder icon. The 
blank page icon clears out any current audio clip. 
Tip: Use Sound Recorder to quickly make audio notes on tests.  

Stopwatch 

From the Home screen, tap Accessories, then tap 
Stopwatch. 

The Stopwatch Application is a simple timer. Tap the 
start button to begin timing; tap it again to stop. 
Subsequent taps will continue to start and stop the 
timer. Tap the middle reset button to return the timer to 
zero. The copy button will place the current time on the 
clipboard for pasting into the Notes screen of 
LabNavigator App, or into the calculator. 



  Appendix A – 1
   

APPENDIX A. LABNAVIGATOR 2 TECHNICAL SPECIFICATIONS 
 
Display 
 11.2 cm x 6.7 cm (13.1 cm diagonal) 

screen 
 800 x 480 pixel color display at 188 dpi 
 LED backlight 
 Portrait or landscape screen orientation 
 High-contrast mode for outdoor visibility 
 
Processor 
 800 MHz Application Processor 
 
Connectivity 
 Wi-Fi 802.11 b/g/n 

 
 
User Interface 
 Resistive touch screen 
 Touch and stylus navigation for efficiency 

and precision 
 
Data Acquisition 
 100,000 samples per second 
 12-bit resolution 
 Built-in GPS, 3-axis accelerometer ( 2 g), 

ambient temperature sensor, light sensor 
(uncalibrated intensity), and microphone 

 
Environmental Durability 
 Operating Temperature: 0 – 45°C 
 Storage Temperature: -30 – 60°C 

 Splash resistant 
 Rugged enclosure designed to withstand a 

fall from lab bench 
 
Size and Weight 
 Size: 8.8 cm x 15.4 cm x 2.5 cm 
 Weight: 350 g 
 
 
Ports 
 5 sensor channels 
 USB port for sensors, flash drives, and 

peripherals 
 USB mini port 
 DC power jack 
 MicroSD/MMC slot 
 Audio in and out 
 
Storage 
 200 MB 
 Expandable with MicroSD and USB flash 

drive 
 
Power 
 Rechargeable, high-capacity battery 
 DC charging/powering through external 

adapter (included) 
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APPENDIX B. LABNAVIGATOR MAINTENANCE 

LabNavigator Battery  

LabNavigator uses a high-quality lithium-ion battery. This is the same chemistry used in 
premium laptop and cell phone batteries, and you can expect similar performance. There is never 
a need to condition the battery by regular full discharge/charge cycles.  

Use only the supplied AC adapter or optional LabNavigator 2 Charging Station (order code  
Nav2-CRG, sold separately) to charge the LabNavigator battery. A replacement adapter can be 
purchased from our web site (order code Nav-PWR). 

The battery takes about eight hours to completely charge. It is safe to leave the battery charging 
indefinitely, and there is no need to fully discharge the battery before charging. Battery life will 
depend on the sensors used, but in most cases you can obtain six or more hours of use before 
recharging. We recommend charging LabNavigator overnight to start the next day with a full 
charge.  

For use with a computer, either the battery must be charged or the LabNavigator must be 
connected to AC power. The LabNavigator cannot operate on USB power alone. When the 
LabNavigator is running and connected to the computer, the USB connection will, however, 
slowly charge the battery. 

When using LabNavigator as a standalone device, the screen will dim after a few minutes of no 
use, even during data collection. However, LabNavigator will not turn itself off until the battery 
is almost discharged. No data will be lost, as LabNavigator App will save a backup file before 
shutting down.  

Battery life will depend on the sensors and features used. To optimize day-to-day battery life, set 
the screen brightness to the minimum acceptable level, and turn off LabNavigator when it is not 
in use. Also disconnect any sensors you are not actively using. To access power-saving options, 
tap Preferences on the Home Screen, then tap Light & Power. 

The long-term life of the battery will vary, but you can expect about three hundred to four 
hundred full charge/discharge cycles before the battery will need to be replaced. In this count, a 
charge from half-way to a full charge would count as half of a charge cycle. In typical school 
use, the battery can last three years or more. Exposure to temperatures over 35°C will 
significantly reduce battery life. 

As a battery reaches the end of its useful life, the run time will become shorter and shorter. 
Eventually the run time will be too short for your application, and you will want to replace the 
battery. Rechargeable batteries are considered a consumable, and as such are warranted for one 
year. A replacement battery can be ordered from our web site (order code LN2-BAT). Recycling 
information is available at www.call2recycle.org.  

 

LabNavigator Case and Screen 

The LabNavigator is water and shock resistant. Do not submerge in liquids. Wipe clean with a 
damp cloth only; do not use any solvents including ammonia or glass cleaners. 
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Stylus Tether 

LabNavigator includes a stylus and a tether. If desired, you can attach the tether to the stylus and 
the LabNavigator. Additional styluses are available from Forston Labs. 

 

LabNavigator Software 

LabNavigator arrives with its own software, LabNavigator App, preloaded. The 
LabNavigator App will be updated from time to time to introduce new features and to improve 
performance. Most users will want to run the latest version available.  

Free updates with step-by-step instructions as they are available can be found at 
www.forstonlabs.com 

 

Screen Calibration 

To do this, tap System from the Home menu. 
Then choose Calibrate Screen.  

Follow the on-screen instructions for tapping the 
plus sign with the stylus.  

If you are unable to access the Calibration tool, 
press and hold the Home key until the Calibration 
tool is displayed. 

 

 

Getting Additional Help 

For access to user manuals, forums, and our technology information library, please visit our web 
site at: 

www.forstonlabs.com 

You may also contact Forston Labs directly:  

800-301-1259  
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APPENDIX C. LICENSE INFORMATION 

 
This product contains certain open source software originated by third parties that is subject to 
the GNU General Public License as published by the Free Software Foundation, GNU 
Library/Lesser General Public License (LGPL) and different and/or additional copyright 
licenses, disclaimers or notices. These licenses give you the right to redistribute and/or modify 
the software. 
 
The software is distributed in the hope that it will be useful, but WITHOUT ANY 
WARRANTY; without even the implied warranty of MERCHANTABILITY or FITNESS FOR 
A PARTICULAR PURPOSE. See the GNU General Public License for more details. 
 
Complete source code for the open source software is available on request from Forston Labs. 
Contact us at info@forstonlabs.com, or by writing to 
 
Source Code Request 
Forston Labs  
320 E. Vine Dr. #128 
Fort Collins, CO 80524 
 
Source code will be made available for download, or you may request a CD-ROM of the code. A 
shipping and handling fee will be charged for a CD-ROM. 
 
The exact terms of GPL, LGPL and some other licenses are provided to you with the source code 
distribution. You may also read the license at http://www.gnu.org/licenses/ 
 

 



  
  

APPENDIX D. WARRANTY 

 

Forston Labs warrants this product (with the exception of the battery) to be free from defects in 
materials and workmanship for a period of five years from the date of shipment to the customer. 
This warranty does not cover damage to the product caused by abuse or improper use. 

The LabNavigator 2 battery is a consumable, and as such, Forston Labs warrants this product to 
be free from defects in materials and workmanship for a period of one year from the date of 
shipment to the customer. 

 

 

Forston Labs  
320 E.Vine Drive #128 
Fort Collins, CO 80524 

info@forstonlabs.com  www.Forstonlabs.com 
 
 

Revised May 29, 2012 
LabNavigator and other marks shown are our trademarks or registered trademarks in the United States. 
All other marks not owned by us that appear herein are the property of their respective owners, who may or may not be affiliated with, connected 
to, or sponsored by us.  
 



 

 

 

SOP Deviation Form 



SOP DEVIATION FORM 
 June 28, 2020

6720 South Macadam Avenue, Suite 125 
Portland, Oregon 97219 

503.670.1108 

\\FUJI\Anchor\Projects\Millennium Bulk Terminals\Remediation\6_Design\4_EDR\Deliverables\Working\03 Appendices\A_PDI Data Summary Report\03 
Attachments\Attachment 1_SOPs\Fluoride Field Screen SOP_DeviationForm.docx 

PROJECT NAME: Former Reynolds Metals Reduction Plant – Longview 

Reason for Deviation 
Water quality parameters were not collected at soil depth intervals where there was an insufficient 
volume of groundwater in the bore hole for both the fluoride sample and parameters.  

Description of Deviation 
The Fluoride Field Screening Using Direct Push Drilling SOP states that a groundwater sample will be 
collected for fluoride field screening and water quality parameters at each 5-foot depth interval. At 
depth intervals where there was not sufficient volume of groundwater for the fluoride field screening 
and water quality parameters only a fluoride sample was collected.  

Special Equipment, Materials, or Personnel Required 
Not applicable 

Description of How Deviation Modifies Project Data Quality Objectives (if 
applicable) 
Deviation has no impact on project Data Quality Objectives 

Initiator's Name: Sasha Norwood Date: 6/28/20 

Field Manager: Tim Stone Date: 6/30/2020 
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:
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Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and
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Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
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Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101
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(30.0‐34.0) Sampling rod sand under its own weight from 30 to 45 ft below ground surface

(0‐0.5) Grass cover and very dark gray, silty SAND (SM) with
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(6.3‐7.0) Soft, moist, brown, sandy gravelly SILT (ML), occasional
organics, no odor

(7.0‐10.0) Soft, dark gray, high plasticity, sandy SILT (ML),
occasional gravel pieces, no odor.
@(7.0) Water table enocuntered

(10.0‐12.0) Loose, moist, red/black/white, poorly graded SAND
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(30.0‐34.0) Sampling rod sand under its own weight from 30 to 45 ft below ground surface

(20.0‐24.0) Medium dense, wet, gray, silty SAND (SM), trace
organics (roots/wood fibers)

@(22.0) Grades to sandier

(24.0‐30.0) Medium dense, wet, dark gray, pooly graded SAND
(SP‐SM) with silt
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2‐11/12‐2020

(0‐1.0) Grass cover and very dark, moist, silty SAND (SM),
contains gravel pieces

(1.0‐3.0) Medium dense, moist, dark brown, silty SAND (SM)
with occasional gravel pieces

(3.0‐4.0) Medium stiff, moist, very dark gray, SILT (ML), with
trace fine grained sand

(4.0‐4.5) Loose, medium dense, SAND (SP)

(4.5‐6.0) Stiff, moist, gray/blue, SILT (ML), with gravel pieces

(6.0‐7.5) Medium dense, moist, dark brown, silty SAND (SM)
with occasional gravel pieces

(7.5‐20.5) Very loose to medium dense, moist, grayish‐brown,
poorly graded SAND (SP)

@(9.2) Grades to medium dense, moist, and
gray/white/black/red

@(15.0) Grades to loose

PDI‐SU02‐
B‐02‐0‐1‐
20200211

PDI‐SU02‐
B‐02‐1‐3‐
20200211

PDI‐SU02‐
B‐02‐3‐4‐
20200211
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9.2‐20.5‐
20200211
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Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101
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2‐11/12‐2020

(7.5‐20.5) Very loose to medium dense, moist, grayish‐brown,
poorly graded SAND (SP)

(20.5‐27.5) Very stiff, moist, gray/blue, SILT (ML), trace organics
(wood debris)

(27.5‐34.0) Loose to dense, moist to wet, dark gray, silty SAND
(SM)

@(34.0) Grades to gray/white/black, medium coarse grained
silty SAND (SM)

@(36.0) Grades to loose

(37.3‐42.5) Medium stiff to stiff, moist, dark gray, SILT (ML) with
fine grained sand, substantial organics

@(39.4‐39.8) Wood pieces encountered

PDI‐SU02‐
B‐02‐25‐27‐
20200211

PDI‐SU02‐
B‐02‐27.5‐34‐
20200211

PDI‐SU02‐B‐02‐
35‐37.3‐
20200212
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B‐02‐37.3‐40‐
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Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101
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42.5

2‐11/12‐2020

(37.3‐42.5) Medium stiff to stiff, moist, dark gray, SILT (ML) with
fine grained sand, substantial organics

End of Boring at 42.5 FT

PDI‐SU02‐
B‐02‐40‐42‐
20200212



Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101
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SU02‐B3

23.61
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41.5

2‐10/11‐2020

@(25.0‐26.5) SPT in heaving sands

(0.0‐2.1) Loose, moist, dark grayis‐ brown, silty SAND (SP),
occasional organics (Landfill Cap)

(2.1‐3.6) Medium dense, moist, dark gray, silty SAND (SM) with
gravel pieces, occasional organics

@(3.4‐4.4) Possible cobble or boulder

@(4.4) Grades to silty SAND (SM) with trace gravel

@(7.0) Grades to siltier

(8.0‐10.0) Loose, moist, SAND (SP), occasional organics

(10.0‐13.3) No recovery. Likely heaving sands according to
driller.

(13.3‐22.5) Soft to medium stiff, moist to wet, very dark
garyish‐borwn, medium to high plasticity, SILT (ML)

@(15.0) Water table encountered
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B‐03‐0‐2.1‐
20200210
PDI‐SU02‐

B‐03‐2.1‐3.6‐
20200210

PDI‐SU02‐
B‐03‐13.5‐20‐
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B‐03‐15‐17‐
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Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101
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41.5

2‐10/11‐2020

@(25.0‐26.5) SPT in heaving sands

(13.3‐22.5) Stiff, moist to wet, very dark garyish‐borwn,
medium to high plasticity, SILT (ML)

(22.5‐25.0) Loose, moist to wet, white/dark gray, poorly graded
SAND (SM) with silt

(25.0‐34.4) Loose, white/gray, SAND (SP)
Likely heaving sands. Water used during drilling to maintain
downward pressure.

(34.4‐40.3) Medium stiff, moist, gray, organic SILT (OH), trace
organics (wood fibers)

@(36.3‐37.5) grades to substantial organics (wood fibers)

PDI‐SU02‐
B‐03‐25‐34.4‐
20200211

PDI‐SU02‐B‐03‐
34.4‐40‐
20200211
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Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101
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2‐10/11‐2020

@(25.0‐26.5) SPT in heaving sands

(34.4‐40.3) Medium stiff, moist, gray, organic SILT (OH), trace
organics (wood fibers)

(40.3‐41.5) Medium stiff, moist, dark grayish‐brown, sandy SILT
(ML)

End of Boring at 41.5 FT



Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101
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‐‐

42.0

2‐14‐2020

(0.0‐1.1) Loose, wet, dark grayish‐brown, silty SAND (SM),
significant organics (grass roots)

(1.1‐6.0) Soft, moist to wet, black, sandy SILT (ML), trace to
some organics (Black Mud)

(6.0‐12.4) Transition to native material at 6.0 FT. Soft, moist,
gray silt (ML) with organics (roots)

@(11.0) Grades to gray/green with orange mottling

(12.4‐25.0) Very loose, moist, gray/white/black, silty SAND (SM)
with pockets of silt (ML)

@(14.4) Pocket of SILT (ML)

@(16.0) Grades to loose

@(16.5) Grades to sandier

@(17.6) Pocket of SILT (ML)

PDI‐SU02‐
B‐04‐1.1‐5‐
20200214

PDI‐SU02‐
B‐04‐5‐7‐
20200214

PDI‐SU02‐B‐04‐
6‐10‐

20200214

PDI‐SU02‐
B‐04‐10‐12‐
20200214

PDI‐SU02‐B‐04‐
12.4‐15‐
20200214

PDI‐SU02‐B‐04‐
15‐20‐
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Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101
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2‐14‐2020

(12.4‐25.0) Medium stiff, moist, gray/white/black, silty SAND
(SM) with pockets of silt (ML)

(25.0‐35.0) Very soft, moist, grayish‐brown, SILT (ML)

@(29.0) Trace organics

@(32.0) Grades to stiff and organic SILT (OH)

@(32.5‐32.6) Wood debris encountered

(35.0‐42.0) Very soft, mosit, Grayish‐brown, elastic SILT (MH)
Wood debris and oranic silt (OL) layer(s) enountered

PDI‐SU02‐B‐04‐
20‐25‐

20200214

PDI‐SU02‐B‐04‐
25‐30‐

20200214

PDI‐SU02‐B‐04‐
30‐32‐

20200214
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B‐04‐35‐40‐
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Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101
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2‐14‐2020

(35.0‐42.0) Very soft, mosit, Grayish‐brown, elastic SILT (MH)
Wood debris and oranic silt (OL) layer(s) enountered

End of Boring at 42 FT
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Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101
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2‐14‐2020

(0‐0.2) Grass Cover and silty SAND (SM) (Top Soil)

(0.2‐0.4) Loose, brown/tan, moist, SAND (SP), with significant
organics (grass roots)

(0.4‐1.1) Soft, moist, black, SILT (ML) with fine grained sand,
occasional organics (Black Mud)

(1.1‐7.5) Stiff, moist, brown/black with orange mottling, elastic
SILT (MH) trace to some organics

@(5.5) Grades to sandier elastic SILT (MH)

@(6.0) Grades to gray/blue

@(7.0) Grades to wet

(7.5‐21.5) Very loose to medium dense, moist to wet, medium
dense, gray/blue, silty SAND (SM), trace organics (grass roots)

@(9.4‐9.8) SAND (SP) lens

@(10.0) Grades to very loose

@(14.3) Grades to sandier

@(15.0) Grades to medium dense

@(19.6‐20) Pocket of SILT (ML)

PDI‐SU02‐
B‐05‐1.1‐5‐
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PDI‐SU02‐
B‐05‐5.5‐7.5‐
20200214

PDI‐SU02‐
B‐05‐7.5‐10‐
20200214

PDI‐SU02‐
B‐05‐10‐15‐
20200214

PDI‐SU02‐
B‐05‐15‐20‐
20200214

1

1

2

4

4

8

1.5

0.5

0.23
(0.06)

0.05
(0)



Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101
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SU02‐B5

15.01

0.0

42.0

2‐14‐2020

(7.5‐21.5) Very loose to medium dense, moist to wet, medium
dense, gray/blue, silty SAND (SM), trace organics (grass roots)

(21.5‐25.0) No Recovery. Sampler drops to 25 FT

(25.0‐35.0) Very soft, olive‐brown, elastic SILT (MH) trace
organics (grass roots), occasional pockets of SILT (ML)

(35.0‐41.5) Very soft, moist, gray, SILT (ML), trace to some
organics (wood fibers)

@(36.3‐37.5) Grades to substantial organics (wood fibers)

PDI‐SU02‐
B‐05‐25‐35‐
20200214

PDI‐SU02‐B‐05‐
35‐37‐

20200214

PDI‐SU02‐
B‐05‐35‐40‐
20200214
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Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101
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0.0

42.0

2‐14‐2020

(35.0‐41.5) Very soft, moist, gray, SILT (ML), trace to some
organics (wood fibers)

End of Boring at 41.5 FT

WOR
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Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101
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SU02‐B6

13.41
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42.0

2‐13‐2020

(0.0‐0.4) Grass cover and top soil

(0.4‐0.9) Very Loose, moist, light brown, silty SAND (SM),
substantial organics

(0.9‐6.7) Very loose, moist to wet,  very dark grayish‐brown,
silty SAND (SM) (Waste), 18.7% OC

@(5.0) Water table encountered

(6.7‐7.4) Very soft, wet, black/brown, SILT (ML), trace organics
(Waste)

(7.4‐12.0) Transition from waste material at 7.4 FT. Very soft,
moist, dark gray, SILT (ML) occassional organics and gravel
pieces.

(12.0‐14.1) Loose to medium dense, moist, dark grayish‐brown,
organic SILT (MH)

@(13.3‐14.1) Grades to Stiff

(14.1‐17.3) Very loose to loose, wet, gray/white/red/black, silty
SAND (SM), trace silt

@(16.0‐16.2) Darker gray/black lens

(17.3‐35.0) Very soft, moist, gray, low plasticity SILT (ML), trace
organics (wood debris)

PDI‐SU02‐B‐06‐
0‐5‐

20200213

PDI‐SU02‐B‐06‐
7.4‐11.5‐
20200213

PDI‐SU02‐
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Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101
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42.0

2‐13‐2020

(17.3‐35.0) Very soft, moist, gray, low plasticity SILT (ML), trace
organics (wood debris)

@(33.7‐33.9) Significant wood debris

(35.0‐42.0) Very soft, moist, dark grayish‐brown, organic SILT
(OH)

PDI‐SU02‐
B‐06‐20‐22‐
20200213

PDI‐SU02‐
B‐06‐20‐25‐
20200213

PDI‐SU02‐
B‐06‐25‐30‐
20200213

PDI‐SU02‐
B‐06‐30‐32‐
20200213

PDI‐SU02‐
B‐06‐30‐35‐
20200213

PDI‐SU02‐
B‐06‐35‐40‐
20200213
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Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101
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SU02‐B6

13.41
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42.0

2‐13‐2020

(35.0‐42.0) Very soft, moist, dark grayish‐brown, organic SILT
(OH)

End of Boring at 42 FT
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Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101
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1003611304908

SU02‐B7

22.31

‐‐

42.0

2‐13‐2020

(0.0‐1.0) Grass cover, silty SAND (SM) (Top Soil)

(1.0‐1.6) Very loose, moist, tan/black, medium coarse silty
SAND (SM), trace organics, trace gravel (Landfill cover)

(1.6‐11.0) Very soft to soft, moist, very dark gray, silty SAND
(SM), trace fine grained sand (Waste), 18.7% OC

@(5.0‐7.0) No recovery of shelby tube

@(9.2) Grades to stiff
@(9.3‐9.5) Pocket of medium stiff, gray, SILT
@(11.0) Transition from waste material

(11.0‐20.7) Very soft to medium stiff, dark gray/green, sandy
SILT (ML), trace gravel pieces, trace organics

@(13.7) Grades to medium stiff to stiff

@(16.0) Grades to very stiff

@(17.9) Grades to soft

PDI‐SU02‐
B‐07‐1.6‐5‐
20200213

PDI‐SU02‐
B‐07‐5‐10‐
20200213

PDI‐SU02‐
B‐07‐10‐12‐
20200213

PDI‐SU02‐
B‐07‐11‐13.7‐
20200213

PDI‐SU02‐
B‐07‐15‐20‐
20200213
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Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101
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2‐13‐2020

(11.0‐20.7) Very soft to medium stiff, dark gray/green, sandy
SILT (ML), trace gravel pieces, trace organics

(20.7‐27.1) Very loose, gray, silty SAND (SM), pockets of clean
sand and wood debris

@(23‐23.8) Wood debris encountered

@(24.3‐24.7) Pocket of clean SAND (SP)

@(26‐26.3) Pocket of clean SAND (SP)

(27.1‐42.0) Very soft to medium stiff, wet, dark gray, SILT (ML),
trace organics

@(33.9‐34.3) Wood debris encountered

PDI‐SU02‐
B‐07‐20‐25‐
20200213

PDI‐SU02‐
B‐07‐27.1‐30‐
20200213

PDI‐SU02‐
B‐07‐30‐35‐
20200213

PDI‐SU02‐
B‐07‐35‐37‐
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PDI‐SU02‐
B‐07‐35‐40‐
20200213
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Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101
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2‐13‐2020

(27.1‐42.0) Very soft to medium stiff, wet, dark gray, SILT (ML),
trace organics

End of Boring at 42.0 FT
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Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101
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1008367302427

SU06‐B1

22.77

‐‐

50.0

2‐24‐2020

Grass Cover, silty SAND (SM) (Top Soil)

(0.4‐4.0) Soft, moist, olive‐brown, lean CLAY (CL) occassional
organics

(4.0‐15.5) Loose to dense, moist, very dark brown, silty SAND
(SM), trace to some gravel

@(7.8‐8.7) Grades to wet and black, possible waste layer (Black
Mud)

@(8.7) Medium dense, moist, very dark brown, silty SAND (SM),
occasional organics

@(10.9) Grades to gray/green

@(12.0) Grades to loose, moist, gray

(15.5‐33.0) Very soft to medium dense, moist, gray/green, SILT
(ML)

PDI‐SU06‐
B‐01‐0‐5‐
20200224
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B‐01‐10‐12‐
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Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101
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2‐24‐2020

(15.5‐33.0) Very soft to medium dense, moist, gray/green, SILT
(ML)

@(21.1‐21.6) Pocket of clean SAND (SP), non‐impacted

@(24.0) Grades to stiff

@(28.0) Grades to medium dense, moist, gray

(33.0‐40.0) Loose to medium dense, moist, gray/white/red,
medium coarse silty SAND (SM)
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B‐01‐20‐25‐
20200224
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Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101
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50.0

2‐24‐2020

(40.0‐45.0) Loose to medium dense, moist, black/white/red,
poorly graded SAND WITH SILT (SP‐SM)

(45.0‐50.0) Medium dense, moist, dark gray, poorly graded
SAND (SP)

End of Boring at 50 FT

PDI‐SU06‐
B‐01‐40‐45‐
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B‐01‐45‐50‐
20200224
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Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101
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1008605302704

SU06‐B02

24.44

‐‐

51.5

2‐22‐2020

(0.0‐0.1) Grass cover

(0.1‐3.9) Very loose to loose, wet, silty SAND (SM), organics
(grass roots)

(3.9‐4.5) Very loose to Loose, moist, black/tan, silty SAND (SM)
with gravel

(4.5‐5.2) Very soft, wet, brown, SILT (ML), trace organics (small
sticks)

(5.2‐10.0) Very soft, moist, black, SILT (ML), fine gray
laminations (Waste).

(10.0‐24.0) Loose to medium dense, moist, very dark gray, silty
SAND (SM) (Waste)

PDI‐SU06‐
B‐02‐0‐5‐
20200222

PDI‐SU06‐
B‐02‐7‐9.5‐
20200222

PDI‐SU06‐
B‐02‐10‐15‐
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Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101
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2‐22‐2020

(10.0‐24.0) Loose to medium dense, moist, very dark gray, silty
SAND (SM) (Waste). No attempt in SPT in heaving sands

(24.0‐24.8) Very stiff, wet, black, SILT (ML) with sand, sediment
clasts encountered (Waste)

(24.8‐26.5) Medium stiff, moist, gray, elastic SILT (MH), black
staining

(26.5‐36.0) Very soft, moist, gray with black staining, sandy SILT
(ML)

@(32.0) Grades to siltier

@(33.0) Grades to sandier

(36.0‐37.0) Very stiff, wet, grayish‐brown, lean CLAY (CL)

(37.0‐42.0) No Recovery
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Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101
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2‐22‐2020

(37.0‐42.0) No Recovery

(42.0‐42.5) Very soft, wet, gray/green, SILT (ML)

(42.5‐45.8) Very loose, wet, dark gray, SILT (ML) with sand

(45.8‐51.5) Very loose, moist, gray, silty SAND (SM)

@(47.8) Grades to sandier, lighter gray
Heaving sands at bottom of casing. No SPT attempt.

End of boring at 51.5 FT
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Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101
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1008845302961

SU06‐B3

22.01
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2‐21‐2020

(0.0‐0.2) Grass cover

(0.2‐4.0) Very loose to loose, moist, gray, silty SAND (SM), trace
organics (grass roots) (Landfill Cover)

(4.0‐13.0) Very soft, moist, dark gray, elastic SILT (MH), trace
fine grained sand (Waste)

@(11.0) Grades to very soft, wet

(13.0‐16.5) Very soft, moist, gray, sandy SILT (ML), trace fine
grained sand. Transitions to native.

(16.5‐23.0) Soft to very stiff, moist, brown, CLAY (CL)

@(19.0‐21.5) Grades to stiff

@(19.2) Grades to gray/green
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Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101
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2‐21‐2020

(16.5‐23.0) Soft to very stiff, moist, brown, CLAY (CL)
@(20.5‐21.2) Contains orange mottling

@(21.5) Grades to very stiff

(23.0‐35.0) Stiff to very stiff, moist, gray, sandy SILT (ML)

(35.0‐40.0) No Recovery. Possible heaving sands.
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B‐03‐23‐25‐
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PDI‐SU06‐
B‐03‐30‐35‐
20200221
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Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101

40

45

50

55

60

‐20

‐25

‐30

‐35

1008845302961

SU06‐B3

22.01

10.0

57.0

2‐21‐2020

(40.0‐52.0) Soft, moist, grayish‐brown, sandy SILT (ML), organics
throughout (marsh grasses), 9.2% OC

@(47.0) Grades to trace organics, SILT (ML), dark grayish‐
brown, 7.6% OC

(52.0‐57.0) Very soft to soft, moist, grayish‐brown, organic SILT
(OL), organics throughout (marsh grasses), 10.9% OC

End of boring at 57 FT
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B‐03‐45‐47‐
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Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101
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SU06‐B4
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2‐20,21‐2020

(0.0‐0.1) Grass cover

(0.1‐5.0) Soft to medium stiff, brown to black, SILT (ML) with
gravel, contains organics (roots)

(5.0‐7.0) Medium stiff, moist, black, SILT (ML) with fine grained
sand, trace gravel and cobbles (Waste)

(7.0‐10.0) Soft to medium stiff, moist, elastic SILT (MH), light to
dark gray, some black staining

(10.0‐15.0) Very soft to soft, moist, gray with orange mottling,
lean CLAY (CL)
@(10.0) Water table encountered.

@(13.7‐14.0) Significant wood debris

(15.0‐20.0) Very soft, most, olive brown, SILT (ML)

@(17.0) Small pockets of organic SILT (OL) encountered

@(19.0) Grades to stiff

PDI‐SU06‐
B‐04‐0‐5‐
20200220

PDI‐SU06‐
B‐04‐7‐10‐
20200220

PDI‐SU06‐
B‐04‐10‐12‐
20200220

PDI‐SU06‐
B‐04‐10‐15‐
20200220

PDI‐SU06‐
B‐04‐15‐20‐
20200220

1

3

4

WOH

WOH

1

2.0

0.5

0.75

0.45
(0.2)

0.1
(0.05)

0.2
(0.06)



Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101
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2‐20,21‐2020

(20.0‐43.0) Very loose to loose, moist, gray, fine grained silty
SAND (SM)

@(38.0) Grades to loose, moist, gray,  interbedding/pockets of
sand and silt

PDI‐SU06‐
B‐04‐20‐25‐
20200220

PDI‐SU06‐
B‐04‐25‐30‐
20200220

PDI‐SU06‐
B‐04‐30‐35‐
20200220
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Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101

40

45

50

55

60

‐20

‐25

‐30

‐35

1009068302858

SU06‐B4
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10

52.0

2‐20,21‐2020

(20.0‐43.0) Very loose to loose, moist, gray, fine grained silty
SAND (SM)

(43.0‐46.0) Soft to medium dense, moist to wet, dark grayish‐
brown, organic SILT (OH), trace organics, 10.3% OC

(46.0‐52.0) Very soft, wet, olive brown, organic SILT (OL), trace
organic material

@(47.0) Trace coarse gravel and fiber‐like organics

@(47.5‐50.0) No Recover, trace clayey SILT (OL) found on
cutting head

End of Boring at 52 FT

PDI‐SU06‐
B‐04‐38.4‐43‐
20200221

PDI‐SU06‐
B‐04‐43‐46‐
20200221

PDI‐SU06‐
B‐04‐50‐52‐
20200221
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Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101
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SU06‐B5

24.74

10.0

52.0

2‐24‐2020

(0.0‐0.3) Grass cover

(0.3‐3.6) Very loose to loose, dark gray, moist to wet, SAND
(SP), occassional organics (Waste)

(3.6‐15.4) Very loose to loose, moist, black, fine grained, silty
SAND (SM), fine gray interbedded layers (Waste)

@(5.4) Grades to wet and occasional pockets of SILT (ML)

@(10.0) Water table encountered

@(15.4‐16.2) Very soft, black, PEAT (PT), contains sticks and
grasses

(16.2‐25.0) Soft to medium stiff, moist, gray/green, Clay (CL)

PDI‐SU06‐
B‐05‐3.6‐5‐
20200224

PDI‐SU06‐
B‐05‐5‐10‐
20200224

PDI‐SU06‐
B‐05‐10‐15‐
20200224

PDI‐SU06‐
B‐05‐15‐20‐
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3

3

7

WOH

WOH

1

WOR

WOR

WOR

0.5 0.4



Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101

20

25

30

35

40

0

‐5

‐10

‐15

1008717302321

SU06‐B5

24.74

10.0

52.0

2‐24‐2020

(16.2‐25.0) Soft to medium stiff, moist, gray/green, Clay (CL)

@(22.2) Grades to very stiff

(25.0‐35.5) Very soft, moist, gray, fine grained sandy SILT (ML)

@(32.0) Grades soft to medium stiff, wet, gray

@(34.2) Grades to very soft, wet, gray

(35.5‐38.0) Medium dense, moist, red/white/gray, silty SAND
(SM)

(38.0‐41.0) Very soft, light gray, moist, SILT (ML) ocasional
organics (wood chips and grasses)
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B‐05‐20‐22‐
20200224

PDI‐SU06‐
B‐05‐20‐25‐
20200224

PDI‐SU06‐
B‐05‐25‐27‐
20200224
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B‐05‐25‐30‐
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PDI‐SU06‐
B‐05‐32‐34.2‐
20200224

PDI‐SU06‐
B‐05‐34.2‐35.5‐
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B‐05‐37‐38‐
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Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101
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2‐24‐2020

(38.0‐41.0) Very soft, light gray, moist, SILT (ML) ocasional
organics (wood chips and grasses)

(41.0‐52.0) Very soft, moist, light gray, elastic SILT (MH),
occasional organics (roots and grasses)

End of Boring at 52 FT

PDI‐SU06‐
B‐05‐40‐45‐
20200224

PDI‐SU06‐
B‐05‐45‐50‐
20200224
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Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101
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1008781.39302606.85

SU06‐B06

24.41

10.0

57.0

2‐21‐2020

@(30.0) Driller reports heaving sand conditions, @(37.0) Artesian well conditions encountered,
@(37.0‐47.0) 0.5 FT recovery due to heave and washout generated by groundwater
conditions, @(57‐58.5) No SPT attempt due to heaving sands

(0.0‐0.1) Grass cover

(0.1‐3.1) Very loose to loose, moist, brown, silty SAND (SM),
trace organics

@(3.1‐5.5) Zone contains poorly graded silty gravels and
cobbles

@(6.0) Grades to black and moist to wet (Waste)

(14.0‐37.0) Very soft to soft, moist, gray/green, sandy SILT (ML),
orange mottling

@(15.0‐16.0) 1 foot layer of  soft, wet, black, sandy SILT (ML)

@(16.0) Grades to  soft, moist to wet, gray/green, sandy SILT
(ML), orange mottling

PDI‐SU06‐
B‐06‐0‐6‐
20200221

PDI‐SU06‐
B‐06‐6‐7‐
20200221

PDI‐SU06‐
B‐06‐7‐9‐
20200221

PDI‐SU06‐
B‐06‐14‐15‐
20200221
PDI‐SU06‐
B‐06‐15‐16‐
20200221
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Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101
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2‐21‐2020

@(30.0) Driller reports heaving sand conditions, @(37.0) Artesian well conditions encountered,
@(37.0‐47.0) 0.5 FT recovery due to heave and washout generated by groundwater
conditions, @(57‐58.5) No SPT attempt due to heaving sands

(14.0‐37.0) Very soft to soft, moist, gray/green, sandy SILT (ML),
orange mottling

@(23.6‐23.7) PEAT (PT) lens
@(23.7) Grades to soft, wet, dark gray, sandy SILT (ML)

@(34.0) Grades to siltier

(37.0‐47.0) Little to No Recovery. Approx. 0.5 feet recovery of
very loose, wet, gray, silty sand.

PDI‐SU06‐
B‐06‐21‐27‐
20200221
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B‐06‐32‐37‐
20200221
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Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101
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2‐21‐2020

@(30.0) Driller reports heaving sand conditions, @(37.0) Artesian well conditions encountered,
@(37.0‐47.0) 0.5 FT recovery due to heave and washout generated by groundwater
conditions, @(57‐58.5) No SPT attempt due to heaving sands

(37.0‐47.0) Little to No Recovery. Approx. 0.5 feet recovery of
very loose, wet, gray, silty sand.

(47.0‐57.0) Medium dense, wet, red/black/white, med coarse
silty SAND (SM), fine interbedding of silt layers

End of Boring 57 FT

PDI‐SU06‐
B‐06‐37‐47‐
20200221

PDI‐SU06‐
B‐06‐50‐57‐
20200221
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Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101
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SU06‐B7
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2‐20‐2020

(0.0‐0.1) Grass cover

(0.1‐4.5) Very loose to loose, moist, brown, SAND to silty SAND
(SP‐SM)

(4.5‐5.3) Soft, moist to wet, black/brown, sandy SILT (ML)

(5.3‐9.0) Very soft, wet, white, CLAY (CL), paint like viscosity
(Waste)

@(5.6‐6.6) Soft moist, black, CLAY (CL) (Waste) layer

(9.0‐19.0) Loose, moist, black, fine grained silty SAND (SM)
(Waste), fine laminations of gray particals (shiny)

@(10.0) Water table encountered

(19.0‐23.0) Soft to stiff, moist, gray/green, SILT (ML)
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B‐07‐3‐4‐
20200220

PDI‐SU06‐
B‐07‐4‐5‐
20200220
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B‐07‐7‐9‐
20200220
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Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101
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2‐20‐2020

(19.0‐23.0) Soft to stiff, moist, gray/green, SILT (ML)

(23.0‐26.0) Loose to medium dense, moist, gray, silty SAND
(SM)

@(26.0) Grades to very loose to loose, moist, red/white/gray,
medium grained

(35.0‐40.5) Very loose to loose, gray, fine to medium grained
SAND (SP)

@(37.0‐45.0) Inner sampler rods drops under own weight

PDI‐SU06‐
B‐07‐20‐22‐
20200220

PDI‐SU06‐
B‐07‐24‐25‐
20200220

PDI‐SU06‐
B‐07‐26‐28‐
20200220

PDI‐SU06‐
B‐07‐28‐30‐
20200220

PDI‐SU06‐
B‐07‐30‐35‐
20200220

PDI‐SU06‐
B‐07‐37‐40.3‐
20200220

WOR

WOR

WOR

3

7

7



Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101
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SU06‐B7

22.73

10.0

56.0

2‐20‐2020

(35.0‐40.5) Very loose to loose, gray, fine to medium grained
SAND (SP)

(40.5‐45.2) Very soft, wet, gray, SILT (ML), occasional organics
(wood sticks). Inner sampler rods drops under own weight to 54
FT

(45.2‐56.0) Very soft, wet, olive‐brown, organic SILT (OH),
organics throughout, 9.3% OC

End of Boring at 56 FT

PDI‐SU06‐
B‐07‐40.3‐46‐
20200220

PDI‐SU06‐
B‐07‐46‐54‐
20200220

WOR

WOR

WOR

WOR

WOR

WOR

WOR

0.75

0.75

0.4

0.3



Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101
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1008676302473.83

SU06‐B8

24.33

0.0

53.5

2‐22‐2020

(0.0‐0.2) Very loose, wet, gray, SAND (SP), occasional organics
(grasses and roots)

(0.2‐21.0) Very soft, wet, black, elastic SILT (MH), fine gray
laminations (Waste)

@(11.5) Grades to sandier

@(14.0) Grades to loose to medium dense, very dark gray,
sandy elastic SILT (MH), 37.8% OC

PDI‐SU06‐
B‐08‐0‐5‐
20200222

PDI‐SU06‐
B‐08‐0‐21‐
20200222

PDI‐SU06‐
B‐08‐10‐17‐
20200222

PDI‐SU06‐
B‐08‐17‐19‐
20200222

WOR

WOR

WOR

2.5 0.8



Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101
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1008676302473.83

SU06‐B8

24.33

0.0

53.5

2‐22‐2020

(0.2‐21.0) Very soft, wet, black, SILT (ML), fine gray laminations
(Waste)

(21.0‐23.1) Soft, moist, gray/green, SILT (ML), occasional wood
debris, black mottling

(23.1‐23.5) Loose, wet, black, silty SAND (SM)

(23.5‐26.6) Very soft to soft, moist, gray/green, SILT (ML),
occasional wood debris, black mottling

(26.6‐31.0) Very loose, moist to wet, white/red/gray, silty SAND
(SM)

(31.2‐37.0) Very soft to soft, moist, gray/green, SILT (ML),
occasional organics and pockets of SAND (SP)

@(32.5) Grades to light gray

@(33.2) Pocket of SAND (SP)

@(36.0) Significant wood debris encountered

(37.0‐39.0) No Recovery

(39.0‐43.8) Medium stiff, moist to wet, gray, sandy SILT (ML)

PDI‐SU06‐
B‐08‐21‐23.1‐
20200222

PDI‐SU06‐
B‐08‐23.5‐26.6‐

20200222

PDI‐SU06‐
B‐08‐29‐31.2‐
20200222

PDI‐SU06‐
B‐08‐31.2‐37‐
20200222

PDI‐SU06‐
B‐08‐37‐42‐
20200222

WOR

WOR

WOR

3.5

0.5

0.65

0.35



Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101
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SU06‐B8

24.33

0.0

53.5

2‐22‐2020

(39.0‐43.8) Medium stiff, moist to wet, gray, sandy SILT (ML)

@(42.0‐42.8) Pocket of SAND (SP)

(43.8‐47.5) Loose, moist, gray, silty SAND (SM)

(47.5‐49.5) Medium stiff, moist to wet, gray, sandy SILT (ML)

(49.5‐51.0) Loose, moist, gray, silty SAND (SM)

(51.0‐53.5) Medium stiff, moist to wet, gray, sandy SILT (ML)

End of Boring at 53.5 FT

PDI‐SU06‐
B‐08‐42‐47‐
20200222

PDI‐SU06‐
B‐08‐47‐52‐
20200222
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Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101
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1008950.04302747.27

SU06‐B9

22.26

10.0

57.0

2‐19‐2020

At 35 FT the outer casing sank under it's own weight to 40 FT, and the inner rod sank to 70 FT
before retrieval was possible. Photos taken, actual depths are unknown.
Photos indicated approximately 5.5 FT of silty SAND (SW‐SM) over approximately 6.0 FT over
SILT (ML)

(0.0‐0.1) Grass cover

(0.1‐4.5) Very loose to loose, moist, brown, SAND (SP)

(4.5‐18.3) Very soft, moist to wet, white/black, SILT (ML)
(Waste)

@(6.5‐7.5) Liquid‐like, wet, white, SILT (ML) (White Mud)

@(7.5‐9.2) Very soft, moist, black, SAND (SP), fine grained,
possible metal like shavings (Waste)

@(10.0) Driller estimates water table at 10.0 FT

(12.3‐18.3) Very loose, moist to wet, gray,  silty SAND (SM)

@(15.0) SAA
@(16‐16.5) Pocket of SILT (ML)

@(16‐16.5) Pocket of SILT (ML)

@(18.3) Transition from waste to native soils

(18.3‐20.0) Hard, moist, gray/green, SILT (ML)

PDI‐SU06‐
B‐09‐0‐4.5‐
20200219

PDI‐SU06‐
B‐09‐7‐9‐
20200219

PDI‐SU06‐
B‐09‐10‐12‐
20200219

PDI‐SU06‐
B‐09‐10‐15‐
20200219

PDI‐SU06‐
B‐09‐18.3‐20‐
20200219

WOR

WOR

WOR

WOR

WOR

WOR

2.0



Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101
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2‐19‐2020

At 35 FT the outer casing sank under it's own weight to 40 FT, and the inner rod sank to 70 FT
before retrieval was possible. Photos taken, actual depths are unknown.
Photos indicated approximately 5.5 FT of silty SAND (SW‐SM) over approximately 6.0 FT over
SILT (ML)

(20.0‐31.1) Very loose to loose, wet, gray, silty SAND (SP)

@(31.1‐31.3) Pocket of SILT (ML)

(31.1‐57.0) No Recovery

PDI‐SU06‐
B‐09‐20‐25‐
20200219

PDI‐SU06‐
B‐09‐25‐30‐
20200219

PDI‐SU06‐
B‐09‐30‐57‐
20200219
(SAND)

PDI‐SU06‐
B‐09‐30‐57‐
20200219
(SILT)
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Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101
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2‐19‐2020

At 35 FT the outer casing sank under it's own weight to 40 FT, and the inner rod sank to 70 FT
before retrieval was possible. Photos taken, actual depths are unknown.
Photos indicated approximately 5.5 FT of silty SAND (SW‐SM) over approximately 6.0 FT over
SILT (ML)

(31.1‐57.0) No Recovery

End of Boring at 57 FT



Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101
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2‐17‐2020

(0.0‐0.3) Grass cover and silty SAND (SM)

(0.3‐0.8) Loose, wet, brown silty SAND (SM)

(0.8‐4.2) No Recovery

(4.2‐8.2) Very soft, wet SILT (ML), (waste)

@(4.7) Tansition zone between cover and waste materials (sand
in mud)

@(6.0) Grades to white, soupy muck/mud

@(6.9) Grades to stiff, black and orange

(8.2‐8.9) Very soft, moist, black, SILT (ML), trace gravels, trace
organic material (impacted native)

(8.9‐20.0) Soft, moist, black to light gray, SILT with Clay (ML‐CL),
trace organic material (non‐impacted)

@(11.0‐11.3) Pocket of gravelly SILT (ML)

@(13.9‐14.9) Layer of substantial organic material (wood
debris), PEAT (PT)

(8.9‐20.0) Very soft, moist, black to light gray, low plasticity,
SILT with clay (ML‐CL). Trace organic material (non‐impacted)

@(18.6) Grades to stiff

PDI‐SU07‐
B‐01‐0‐5‐
20200217

PDI‐SU07‐
B‐01‐5‐8.9‐
20200217

PDI‐SU07‐
B‐01‐8.9‐10‐
20200217

PDI‐SU07‐
B‐01‐10‐12‐
20200217

PDI‐SU07‐
B‐01‐10‐15‐
20200217

PDI‐SU07‐
B‐01‐15‐20‐
20200217
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Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101
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SU07‐B1
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52.0

2‐17‐2020

(20.0‐25.5) Very soft, moist, grayish brown, SILT (ML), trace
wood debris

(25.5‐26.5) Layer of very soft, wet, dark grayish brown, elastic
SILT (MH)

(26.5‐32.2) Very soft, moist, dark grayish‐brown, organic SILT
(OL), trace wood debris, 9.1% OC

@(31.4) Grades to wet

(32.2‐38.0) Very soft, moist, dark brown, organic SILT (OH),
wood fibers and occasional sticks, 8.8% OC

(38.0‐45.0) Very soft, moist, light gray, SILT (ML), cobble sized
sediment clasts with intermixed wood debris encountered

PDI‐SU07‐
B‐01‐20‐25‐
20200217

PDI‐SU07‐
B‐01‐25‐30‐
20200217
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B‐01‐30‐35‐
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Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101
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1009265303449

SU07‐B1

11.30

0.0

52.0

2‐17‐2020

(38.0‐45.0) Very soft, moist, light gray, SILT (ML), cobble sized
sediment clasts with intermixed wood debris encountered

(45.0‐52.0) Very soft, moist, olive‐brown, elastic SILT (MH)

End of boring at 52 FT
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B‐01‐40‐45‐
20200217
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B‐01‐45‐50‐
20200217

WOR

WOR

WOR

WOR

WOR

WOR

WOR

WOR

WOR

WOR



Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101
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SU07‐B2

11.70

0.0

42.0

2‐18‐2020

(0‐0.2) Grass with gravel (SM)

(0.2‐2.0) Very soft to soft, damp, grayish brown SILT (ML),
ocassional organic material

(2.0‐3.0) Very loose to  Loose, wet, black SAND with silt (SW‐
SM) (Waste)

(3.0‐8.0) Very soft, moist, dark gray SILT (ML), trace organics

@(3.0) Pieces of gravel

(8.0‐18.0) Very soft, moist, very dark brown silty, PEAT (PT),with
significant organic material, 45.4% OC

(18.0‐25.0) Very soft, moist, dark gray organic SILT (OL), trace
organics
@(19.4) Grades to medium sitff and with significant organics
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B‐03‐5‐10‐
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Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101
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1009505302938

SU07‐B2

11.70

0.0

42.0

2‐18‐2020

(18.0‐25.0) Very soft, moist, dark gray organic SILT (OL), trace
organic material

(25.0‐30.0) Soft to medium stiff, moist, dark gray CLAY (CH),
trace organic material

@(28.6‐29) Layer of wood debris

(30.0‐42.0) Very soft, moist, olive‐brown, elastic SILT (MH)

@(35.5) Grades to medium stiff

PDI‐SU07‐
B‐03‐20‐25.3‐
20200218

PDI‐SU07‐
B‐03‐25.3‐30‐
20200218

PDI‐SU07‐
B‐03‐30‐32‐
20200218

PDI‐SU07‐
B‐03‐30‐35‐
20200218

PDI‐SU07‐
B‐03‐35‐40‐
20200218
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Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101
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SU07‐B2
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2‐18‐2020

(30.0‐42.0) Very soft, moist, olive‐brown, elastic SILT (MH)

End of boring at 42 FT



Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101
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1009189302980

SU07‐B3
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0.0

42.0

2‐18‐2020

(0‐0.3) Grass and silty SAND (SM)

(0.3‐1.3) Very loose to loose, wet, gray to black, poorly graded
SAND (SP). Decomposing odor

(1.3‐6.4) Very soft, wet, white with brown smeering, white mud
SILT (ML), contains pockets of medium grained sand

(6.4‐10.0)  Very soft to soft, wet, dark brown to black, PEAT (PT)

(10.0‐18.2) Very soft to medium stiff, moist, gray, SILT (ML),
occasional wood debris and sediment clasts

@(10.7) Piece of wood debris

@(14.4) 2‐inch diameter sediment clast encountered

@(16.0) Grades to soft
@(16‐16.1) Wood debris

@(18.2‐22.0) Very soft, moist, dark grayish‐brown, organic SILT
(OH), 9% OC

PDI‐SU07‐
B‐03‐0‐5.0‐
20200218

PDI‐SU07‐
B‐03‐5.0‐10.0‐
20200218

PDI‐SU07‐
B‐03‐10.0‐12.0‐
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B‐03‐12.0‐15.0‐

20200218

PDI‐SU07‐
B‐03‐15.0‐20.0‐
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Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101

20

25

30

35

40

‐10

‐15

‐20

‐25

1009189302980

SU07‐B3

11.45

0.0

42.0

2‐18‐2020

@(18.2‐22.0) Very soft, moist, dark grayish‐brown, organic SILT
(OH), 9% OC

(22.0‐30.0) Very soft to medium stiff, moist, dark grayish‐
brown, SILT (ML), occasional wood debris and sediment clasts,
13.2% OC

@(23.5‐23.9) Wood piece encountered

@(25.3‐26.0) Grades to sandier

@(26.9‐29.0) Grades to stiff, sandy SILT (ML)

(30.0‐32.0) Very soft to soft, moist to wet, very dark brown,
organic SILT (OH), 10.2% OC

(32.0‐42.0) Grades to very soft to soft, moist, dark gray, elastic
SILT (MH)
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B‐03‐25.3‐30.0‐
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B‐03‐30.0‐32.0‐

20200218

PDI‐SU07‐
B‐03‐32.0‐35.0‐
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Ground Surface Elevation (ft):

Sheet 3 of 3Soil Boring Log
D
ep

th
 (
ft
)

V
al
u
es
 L
es
s

El
ev
at
io
n
 (
ft
)

Th
an

 1

Sa
m
p
le
s

Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101
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2‐18‐2020

(32.0‐42.0) Grades to very soft to soft, moist, dark gray, elastic
SILT (MH)

End of Boring at 42 FT
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Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101

0

5

10

15

20

10

5

0

‐5

1009301.93303178.19

SU07‐B4

11.53

0.0

62.0

2‐17,18‐2020

(0.0‐0.5) Grass and sandy topsoil

(0.5‐0.8) Very Loose, wet, gray to black SAND (SM) (Waste)

(0.8‐4.5) No Recovery

(4.5‐7.0) Very soft, wet, white with brown smeering, MH
(Waste)

(7.0‐13.2) Very soft, moist, very dark brown, organic SILT (OH),
31.6% OC

@(7.5) Grades to gray

@(9.1‐13.2) Grades to brown and light gray, very dark grayish‐
brown, PEAT (PT), 31.1% OC

(13.2‐17.1) Very soft, wet, dark gray SILT (ML) with trace
organics

(16.2‐17.1) Very soft, moist, brown, PEAT (PT), contains wood
debris

(17.1‐25.0) Very soft to medium stiff, dark grayish‐brown, SILT
(ML), 3.5% OC
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Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101
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1009301.93303178.19

SU07‐B4

11.53

0.0

62.0

2‐17,18‐2020

(17.1‐25.0) Very soft to medium stiff, dark grayish‐brown SILT
(ML), 3.5% OC

(25.0‐30.0) Very soft to soft, wet, dark grayish‐brown, organic
SILT (OL), 7.1% OC

(30.0‐35.0) Very soft to soft, wet, dark brown, silty CLAY (CL)

(35.0‐40.0) Very soft, wet, dark grayish‐brown, organic SILT
(OH)

PDI‐SU07‐
B‐04‐25‐30‐
20200217

PDI‐SU07‐
B‐04‐30‐32‐
20200217

PDI‐SU07‐
B‐04‐32‐35‐
20200217

PDI‐SU07‐
B‐04‐35‐40‐
20200217

PDI‐SU07‐
B‐04‐40‐42‐
20200218
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Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101
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1009301.93303178.19

SU07‐B4

11.53

0.0

62.0

2‐17,18‐2020

(40.0‐62.0) Very soft, wet, dark to very dark grayish‐brown, SILT
(ML) with interbedded layers of organic SILT (OL) throughout

@(47.0) Grades to soft and siltier, dark grayish‐brown, organic
SILT (OL), 10% OC

@(49.0) Lens of organic wood fibers

@(52.0) Significant wood debris, dark grayish‐brown, oranic
SILT (OH), 6.9% OC

PDI‐SU07‐
B‐04‐45‐50‐
20200218

PDI‐SU07‐
B‐04‐50‐52‐
20200218

PDI‐SU07‐
B‐04‐52‐55‐
20200218

PDI‐SU07‐
B‐04‐55‐60‐
20200218
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Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101

60

‐50

1009301.93303178.19

SU07‐B4

11.53

0.0

62.0

2‐17,18‐2020

(40.0‐62.0) Very soft, wet, dark to very dark grayish‐brown,
organic SILT (OL)

End of Boring at 62 FT
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Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101

0

5

10

15

20

30

25

20

15

1007141302942

SU10‐B1

31.72

20

41.5

2‐19‐2020

(0‐0.1) Grass Cover and medium dense, poorly graded SAND
(SP). (Top of Berm)

(0.1‐15.0) Medium dense, moist, black/white, poorly graded
SAND (SP)

@(1.0‐1.2) Occasional coarse gravel

@(2.5) Cobble piece encountered

@(11.0) Grades to loose

@(14.0) Pocket (4‐in. diam) of stiff, moist, brown, SILT (ML)

(15.0‐20.7) Very loose to loose, moist, dark grayish‐brown,
poorly graded SAND WITH SILT (SP‐SM)

@(20.0) Water table encountered

PDI‐SU10‐
B‐01‐0‐5‐
20200219

PDI‐SU10‐
B‐01‐6‐10‐
20200219

PDI‐SU10‐
B‐01‐10‐15‐
20200219

PDI‐SU10‐
B‐01‐15‐20‐
20200219
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Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101

20

25

30

35

40

10

5

0

‐5

1007141302942

SU10‐B1

31.72

20

41.5

2‐19‐2020

(15.0‐20.7) Very loose to loose, moist, dark grayish‐brown,
poorly graded SAND with silt (SP‐SM)

(20.7‐25.0) Medium stiff, moist, gray, SILT (ML), occasional
wood pieces

(25.0‐28.0) Medium stiff, moist, grayish‐brown, organic SILT
(OH), 6.2% OC

@(27.3‐27.8) Pocket of well‐graded SAND WITH SILT (SW‐SM)

(28.0‐35.0) Soft to stiff, moist, gray, SILT (ML)

@(30.6‐30.9) Pocket of well‐graded SAND with silt (SW‐SM)
@(31.0) Grades to soft

@(32.0) Grades to medium stiff, then to soft

@(35‐41.5) Grades to medium stiff, grayish‐brown, low
plasticity organic SILT (OL)

PDI‐SU10‐
B‐01‐20‐25‐
20200219

PDI‐SU10‐
B‐01‐25‐27‐
20200219

PDI‐SU10‐
B‐01‐25‐30‐
20200219

PDI‐SU10‐
B‐01‐30‐35‐
20200219

PDI‐SU10‐
B‐01‐35‐40‐
20200219
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Ground Surface Elevation (ft):
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Observed Water Table Depth (ft):

Total Depth (ft):

Hammer Efficiency (%): UNKNOWN

Hammer: 140‐lb Auto Hammer

Method: Rotary Sonic

Contractor: Yellow Jacket Drilling

Client: Millennium Bulk Terminals ‐ Longview, LLC

Project #: 200730‐01.02

Collection Date:

E/LONG:

Vert. Datum: NAVD88

Logged By: Garrett Timm

Project: Former Reynolds Metal Reduction
Plant ‐ Longview N/LAT:

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%)

10020 5021 5 10

Soil Description
Samples and descriptions are in recovered depths.

Classification scheme: USCSLi
th
o
lo
gy

P
P
 (
TS
F)

TV
 (
TS
F)

Location: Longview, Washington

Horiz. Datum: Washington State Plane Feet

Notes:SPT N‐Value

Moisture Content (%)

1201 Third Avenue, Suite 2600
Seattle, WA 98101
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2‐19‐2020

@(35‐41.5) Grades to medium stiff, grayish‐brown, low
plasticity organic SILT (OL)

End of Boring at 41.5 FT
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Total Depth (ft):

Hammer: 140‐lb Auto Hammer

Collection Date:

E/LONG:N/LAT:

10020 5021 5 10

Soil Description

Project #: 210002‐01.03

Method: Direct Push

Sa
m
p
le
 T
yp

e

Client: NWA Alcoa

Contractor: Cascade Environmental

Location: Longview, Washington

Logged By: Sam Giannakos

Horiz. Datum: Washington State Plane Feet

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Ground Surface Elevation (ft):Hammer Efficiency (%): UNKNOWN 2‐inch Dual Tube Liner

Vert. Datum: NAVD88

Observed Water Table Depth (ft):

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%) Samples and descriptions are in recovered depths.
Classification scheme: USCSSample Name
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gy

Project: Alcoa ‐ NWA Longview

C
o
u
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ts
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w
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 T
es
t

Soil Boring Log

Notes:SPT N‐Value

1201 Third Avenue, Suite 2600
Seattle, WA 98101

Moisture Content (%)
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2/22/22

1) Boring PDI3‐B01 was terminated at 40.5 feet on 2/22/22. Cascade returned to the location on 2/23/22 to
drill to 40 feet below ground surface and sample from 40 to 50 feet below ground surface.
2) MC: Moisture Content, GS: Grain Size, AL: Atterberg Limits, SG: Specific Gravity, OC: Organic Content
3) WOR: Weight of Rod. WOH: Weight of Hammer

0 to 0.25 ft: Top soil with organics.
0.25 to 3 ft: Loose, moist, grayish‐brown, POORLY GRADED SAND
with SILT (SP‐SM), medium grained.

@2.3 ft: Reddish brown staining, piece of gravel encountered

3 to 6 ft: No Recovery, very soft material encountered

6 to 16.5 ft: Very soft, moist, gray, SILT (ML) with clay and sand,
non‐plastic.
@6 ft: Split spoon sank into subsurface under its own weight when
seated due to soft subsurface. Split spoon removed and interval
from 6 to 9 feet sampled over via direct push.

@10 ft: Grades to wet

@12.9 to 13.6 ft: Layer of black stained, wood waste encountered

@15.3 ft: Black staining

@15.9 ft: Thin piece of wood encountered

16.5 to 21.5 ft: Loose, moist to wet, gray, SILTY SAND (SM), fine
grained sand with trace silt, trace hydrogen sulfide‐like odor.

@18.7 ft: Grades to damp
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B01 ‐ 0 ‐ 3
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B01 ‐ 9 ‐ 10.5

B01 ‐ 10.5 ‐
12.7

B01  ‐ 12.7 ‐
16.5

B01 ‐ 16.5 ‐ 20



Sheet 2 of 3
D
ep

th
 (
ft
)

El
ev
at
io
n
 (
ft
)

Total Depth (ft):

Hammer: 140‐lb Auto Hammer

Collection Date:

E/LONG:N/LAT:

10020 5021 5 10

Soil Description

Project #: 210002‐01.03

Method: Direct Push

Sa
m
p
le
 T
yp

e

Client: NWA Alcoa

Contractor: Cascade Environmental

Location: Longview, Washington

Logged By: Sam Giannakos

Horiz. Datum: Washington State Plane Feet

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Ground Surface Elevation (ft):Hammer Efficiency (%): UNKNOWN 2‐inch Dual Tube Liner

Vert. Datum: NAVD88

Observed Water Table Depth (ft):

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%) Samples and descriptions are in recovered depths.
Classification scheme: USCSSample Name

Li
th
o
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gy

Project: Alcoa ‐ NWA Longview

C
o
u
n
ts

B
lo
w
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b
 T
es
t

Soil Boring Log

Notes:SPT N‐Value

1201 Third Avenue, Suite 2600
Seattle, WA 98101

Moisture Content (%)

Split Spoon
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2/22/22

1) Boring PDI3‐B01 was terminated at 40.5 feet on 2/22/22. Cascade returned to the location on 2/23/22 to
drill to 40 feet below ground surface and sample from 40 to 50 feet below ground surface.
2) MC: Moisture Content, GS: Grain Size, AL: Atterberg Limits, SG: Specific Gravity, OC: Organic Content
3) WOR: Weight of Rod. WOH: Weight of Hammer

16.5 to 21.5 ft: Loose, moist to wet, gray, SILTY SAND (SM), fine
grained sand with trace silt, trace hydrogen sulfide‐like odor.

21.5 to 50 feet: Very soft, damp, olive gray, SILT (MH) with clay,
medium plasticity, occasional organic debris, no odor.

@25 ft: No recovery in split spoon

@32 ft: Grades to moderate organic material

@38.6 ft: Grades to trace organic material
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B01 ‐ 21.5 ‐ 25
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B01 ‐ 31.5 ‐
41.5
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Total Depth (ft):

Hammer: 140‐lb Auto Hammer

Collection Date:

E/LONG:N/LAT:

10020 5021 5 10

Soil Description

Project #: 210002‐01.03

Method: Direct Push

Sa
m
p
le
 T
yp

e

Client: NWA Alcoa

Contractor: Cascade Environmental

Location: Longview, Washington

Logged By: Sam Giannakos

Horiz. Datum: Washington State Plane Feet

Sampler(s): 2‐inch OD/1.375‐inch ID Split Spoon

Ground Surface Elevation (ft):Hammer Efficiency (%): UNKNOWN 2‐inch Dual Tube Liner

Vert. Datum: NAVD88

Observed Water Table Depth (ft):

Uncorrected Standard Penetration
Resistance (blows per foot) and

Moisture Content (%) Samples and descriptions are in recovered depths.
Classification scheme: USCSSample Name
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Project: Alcoa ‐ NWA Longview

C
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ts
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t

Soil Boring Log

Notes:SPT N‐Value

1201 Third Avenue, Suite 2600
Seattle, WA 98101

Moisture Content (%)
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1) Boring PDI3‐B01 was terminated at 40.5 feet on 2/22/22. Cascade returned to the location on 2/23/22 to
drill to 40 feet below ground surface and sample from 40 to 50 feet below ground surface.
2) MC: Moisture Content, GS: Grain Size, AL: Atterberg Limits, SG: Specific Gravity, OC: Organic Content
3) WOR: Weight of Rod. WOH: Weight of Hammer

21.5 to 50 feet: Very soft, damp, olive gray, SILT (MH) with clay,
medium plasticity, occasional organic debris, no odor.

@47.6 to 48.3 ft: Wood fibers encountered

End of Boring at 50 feet.
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50
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Total Depth (ft):

Hammer: 140‐lb Auto Hammer

Collection Date:

E/LONG:N/LAT:

10020 5021 5 10

Soil Description

Project #: 210002‐01.03

Method: Direct Push

Sa
m
p
le
 T
yp

e

Client: NWA Alcoa

Contractor: Cascade Environmental

Location: Longview, Washington

Logged By: Sam Giannakos

Horiz. Datum: Washington State Plane Feet
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